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Introduction                  

Introduction  
This document should really be called the “ASRC 
Branding, Style, Production, Publishing and 
Collaborative Editing Guide” but that’s too long. And 
“Branding Guide” is the standard term that corpora-
tions tend to use, and it’s good to stick with a standard 
term, but we wanted to get across the idea that it also 
has technical information about how to collaborate and 
publish our documents, so we changed it to “Branding 
and Publication Guide.”.

These days, big corporations often have very slick, 
very detailed branding manuals. They are expensive 
and much more than the ASRC needs. These guides are 
often 30-50 glossy pages with a great amount of detail. 
Why? Because having the logo always look the same, 
having the letterhead always look the same, and having 
official documents always look the same is a good thing. 
Consistency reassures customers and suppliers that the 
company is in solid shape and that they should con-
tinue dealing with it. A professional as well as consistent 
appearance reassures as well.

We already have some branding standards: the blue 
shirt and the ASRC patch, described in http://archive.
asrc.net/ASRC-Admin/ASRC-Uniform/2013-03-05-
ASRC-Uniform-Simple.pdf. 

In the beginning of the ASRC, we had standard 
printed stationery. But over the past 40 years, things 
have changed. Now, you can just drag and drop an 
ASRC logo graphic into the top of a document and 
assume (wrongly) that it creates an official letterhead. 
The size, colors, position and quality of the logo there-
fore vary. A lot. The same thing occurs with our official 
documents, which also vary a lot in terms of margins, 
typeface, and other design elements such as big pretty 
pictures on the front page. 

For the same reasons as for a large corporation, better 
branding would be good for the ASRC. We don’t need 
a slick glossy $10,000 35-page branding manual, but for 
the ASRC, at least a little bit of branding and standard-
ization seems like a good idea. 

Thus, this Branding and Publishing Guide.
And, we need guidance on how to collaborate on, edit 

and publish, both print and online, our publications and 
governing documents. That is the “publishing” part of 
the title, and is covered in the subsequent sections.

The ASRC has three major types of documents:

•	 Governing documents are under the purview of 
the ASRC Board of Directors and require a vote 
of the Board of Directors to revise. There are two 
exceptions. The Credentialing Policy Manual must 
be approved instead by the ASRC Credentialing 
Board. To change the Remote Support Corps Charter, 
the Remote Support Corps must vote on proposed 
revisions which then go to the entire ASRC Board of 
Directors for approval. Our governing documents are 
the:
	· ASRC Administration Manual
	· ASRC Articles of Incorporation
	· ASRC Branding and Publishing Guide
	· ASRC Bylaws
	· ASRC Credentialing Policy Manual
	· ASRC Remote Support Corps Charter
	· ASRC Training Standards

•	 Official Publications. These include Essentials 
for Search and Rescue and the One-Pagers. These 
are developed and approved by the Publications 
Committee; the structure and function of the 
Publications Committee is documented in the 
Admin Manual.

•	 Internal Documents. These are generally created 
by a single ASRC member author or committee. For 
the sake of branding, even if just used internally, we 
prefer that they be formatted with the Word tem-
plates available in the Admin/Branding section of 
the ASRC Archive http://archive.asrc.net and linked 
on the Intranet/Sharepoint site at http://home.asrc.
net. They are the responsibility of whoever created 
them or whoever has been assigned custody of the 
documents. Examples include:
	· Agendas
	· Minutes
	· Meeting Sign-ins
	· Certificates for Awards

Note the use of Creative Commons licenses rather 
than a copyright. These specifically allow people to 
print and distribute without permission. It also permits 
people to make their own adaptations, provided they 
acknowledge that it was adapted from something the 
ASRC produced. This makes it more likely that those 
outside the ASRC will use it, which is good for them 
and for ASRC branding. 

http://archive.asrc.net/ASRC-Admin/ASRC-Uniform/2013-03-05-ASRC-Uniform-Simple.pdf
http://archive.asrc.net/ASRC-Admin/ASRC-Uniform/2013-03-05-ASRC-Uniform-Simple.pdf
http://archive.asrc.net/ASRC-Admin/ASRC-Uniform/2013-03-05-ASRC-Uniform-Simple.pdf
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Writing Style                  

Writing Style  
The ASRC has no rules for style. It does, however, 
strongly recommend industry-standard best practices.

The ASRC recommends following standard writing 
principles such as those Strunk and White’s Elements of 
Style. One of the most famous maxims from this book 
is “Omit Needless Words.” As an extension of this, you 
should use short words instead of long words wherever 
possible: also instead of additionally, use instead of 
utilize. It is still in print, and is available in a free online 
version.

Another good short, simple reference for technical 
writing is Morris Bolsky’s Better Scientific and Technical 

Writing. It is out of print but can sometimes be found 
used and is available in an online PDF.

One guideline specific to the ASRC: when writing 
about SAR teams in general, use teams; when writing 
about teams that are members groups of the ASRC, use 
the term Groups (capitalized) instead, as this is what is 
used in our governing documents.

Another is since the ASRC moved to four levels of 
Field credentialing (Field IV, Field III, Field II and Field 
I) the terms field team leader and field team member 
should generally be lower case, unless they refer to the 
prior ASRC credentialing levels of Field Team Leader 
and Field Team Member. 
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Logo  
The official ASRC logo is an electronic version in Adobe 
Illustrator .ai format. You can’t use this .ai format file in, 
for example, Microsoft Word, but it can and has been 
exported to other versions that you can use directly.1 

There are raster bitmap versions – .jpg and .png – but 
you shouldn’t use these unless absolutely necessary. 
Why? Because when enlarged they get jagged edges 
(pixelated).

However, there are vector resizable versions of the 
logo, which stay sharp no matter how much you enlarge 
them. 

There are vector in .emf (Enhanced Windows 
Metafile) format, which you can drag and drop into 
many programs, including the current version of 
Microsoft Word. There are also .eps (encapsulated 
PostScript) that can be dragged and dropped into Adobe 
programs, such as Acrobat, and if printing something 
with a commercial printer, is one of the formats they 
prefer. 

You can find this document and the logo files in 
the ASRC Archive, archive.asrc.net > ASRC-Admin > 
ASRC-Branding. 

If you use the logo in a small size, the standard 
colors work well. But if you use a large size, such as on 
stationery, the logo’s color might be overwhelming. Here 
are examples of a small, full-color logo, and a larger one 
desaturated by 15%. “Desaturate” is to decrease the sat-
uration, or colorfulness, of a graphic’s colors. They will 
look different in different contexts, such as on the cover 
of a manual or at the top of our letterhead. We recom-
mend the desaturated one if you use a larger version of 
the logo. 

Patches

ASRC patches are 4.5 inches in diameter with merrowed 
edges, orange surround is not embroidered, remainder 
embroidered. Rocker bars are on orange non-embroi-
dered material with merrowed edges; original artwork is 
available in the ASRC Archive in Adobe Illustrator and 
PDF formats:
•	 Above patch: REMOTE SUPPORT
•	 Below patch: FIELD III
•	 Below patch: FIELD II
•	 Below patch: FIELD I
•	 Below patch: SEARCH MANAGER 

1 There is a certain parallel with the standard meter bar, composed of 
an alloy of 90% platinum and 10% iridium, that was created in 1889 
and resides in the Bureau International des Poids et Mesures in Sèvres, 
France. 

Decals

For making decals (stickers) with the ASRC logo, 
it is likely that decal suppliers (for instance Moritz 
Embroidery, the only domestic US patch and decal 
manufacturer, conveniently in the ASRC region in East 
Stroudsburg, PA, and a regular source of ASRC patches 
and decals; our contact in 2021 was Claus Slama, claus.
slama@moritzembroidery.com) require that the type 
on the logo be converted into outlines. That is because 
few suppliers have our Scala Sans typeface on their 
computers.

In order to convert the text to outlines, you must 
select the text in Illustrator with the selection or direct 
selection tool – or easier, with the Layers Panel – and 
then from the menu, pick Create Outlines. If you try to 
select the text with the text tool, Create Outlines will be 
greyed out and not available.

For the main logo itself, in the ASRC Archive are the 
following versions where this has been done:

2018-01-14-New-ASRC-Logo-Text-Outlines.ai
2018-01-14-New-ASRC-Logo-Text-Outlines.pdf 

Logo Colors

Here are the official colors for the ASRC logo, whether 
on a website or on a printed document or a patch. These 
have been visually matched with the colors of the orig-
inal ASRC patch #069, except that the snake has been 
made more yellow to account for fading. This patch has 
been protected from ultraviolet light and at a controlled 
temperature since it was created about 40 years ago, 
which is a fancy way to say it was in a closet. 

There is also a version of the logo with desaturated 
colors for use at large sizes. The desaturated RGB colors 
are also listed.  

Orange Background and Orange 
Line Around Star of Life

PANTONE 	 158 C 
RGB:		  232, 119, 54 
LAB:		  L* 63.53 a* 43.77 b* 63.01
HTML:	 E87722
CMYK:	 0, 49, 77, 9
HSL/HSB:		  22, 79, 56
Desaturated RGB: 218, 127, 73

Green mountains
PANTONE 7740 C
RGB: 		 58, 145, 63
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LAB:		  L* 53.13 a* -40.74 b* 33.43 
HTML:	 3A913F
CMYK:	 60, 0, 57, 43
HSL/HSB:	 123, 43, 40
Desaturated RGB: 86, 147, 80

Light blue sky
PANTONE 	 291 C
RGB:		  155, 203, 235
LAB:		  L* 79.43 a*-8.06 b*-20.85
HTML:	 9BCBEB
CMYK:	 38, 4, 0, 0
HSL/HSB:	 204, 67, 76
Desaturated RGB: 165, 203, 230

Dark blue star of life
PANTONE 	 7670 C
RGB:		  86, 82, 148
LAB:		  L* 37.63 a* 15.82 b* -36.55
HTML:	 565294
CMYK:	 42, 45, 0, 42
HSL/HSB:	 244, 29, 45
Desaturated RGB: 98, 92, 146

Yellow snake on staff of Asclepius
PANTONE 394 C

RGB:		  237, 233, 57
LAB:		  L* 90.68 a* -11.91 b* 78.41
HTML:	 EDE939
CMYK:	 0, 2, 76, 7
HSL/HSB:	 59, 83, 58
Desaturated RGB: 232, 229, 97

Silver staff of Asclepius
PANTONE Cool Gray 3 C
RGB:		  200, 201, 199
LAB:		  L*80.83 a*-0.71 b*0.87
HTML:	 C8C9C7
CMYK:	 8, 5, 7, 16
HSL/HSB:	 90, 2, 78
Desaturated RGB: 201, 201, 199

Black letters and outline 
around staff of Asclepius

PANTONE Black C
RGB:		  45, 41, 38
LAB:		  L*16.91 a*1.18 b*2.62
HTML:	 2D2926
CMYK:	 63, 62, 59, 94
HSL/HSB:	 26, 8, 16
Desaturated RGB: 35, 31, 32
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Stationery and Internal Documents  
Graphics of the stationery and internal documents are 
on the pages following the text below. 

Templates

Available in the ASRC Archive (http://archive.asrc.net) 
and through a link in the ASRC Intranet/SharePoint site 
(http://home.asrc.net) are Microsoft Word templates for
•	 Official ASRC letters
•	 Official ASRC internal documents (with a smaller 

header to leave more room for text)
•	 ASRC Agendas/Minutes (which use the internal 

document header)
Examples of the letter template and the internal doc-

ument template, as used to create an Agenda template 
and Minutes template and meeting sign-in, are shown 
below. 

The Agenda and Minutes templates, shown below, use 
automatic numbering of Microsoft Word heading styles, 
as opposed to a numbered list. Unlike a numbered list, 
this allows typing an unlimited number of plain para-
graphs between the headings. 

It also preserves the ability to use the Microsoft 
Word Navigation Pane on the left (View > Show > 
Navigation). This provides an overview and makes it 
easier to quickly rearrange sections, especially when cre-
ating minutes where business is conducted in a different  
order than that projected in the Agenda. 

Stationery Logo

Gradually the original stationery went away, as people 
switched from typewriters to word processors. There 
have been grayscale versions of the ASRC logo, but the 
color logo has been dominant on ASRC documents over 
the past couple of decades. It’s also been much smaller 
than on the original stationery, perhaps since a sub-
dued-color version was not readily available. The 15% 
desaturated version we use in the stationery header on 
a following page is about the same size as the black and 
white version on the original stationery; in color it was 
too much, but desaturated 15%, the size of the original 
seems to work even in color.

Stationery Typefaces

Given the original typeface weight is not available in 
digital format, we can’t have the original typeface, even 

if we wanted to. The ASRC chose the original News 
Gothic smallcaps typeface as it gave an impression of 
professionalism. There’s nothing wrong with that, but 
things have changed over the past 40 years, and News 
Gothic now seems a bit stodgy and old-fashioned (see 
Background at end). We still need something that looks 
professional, but forward-looking too. It needs to be 
appropriate to an organization on the leading edge of 
search and rescue. We do want a sans-serif typeface, as 
this is standard for titling and headings. (Serifs are the 
little flanges on the ends of letters, such as in the capital 
letter i. The capital “I” in this typeface, the default 
Calibri of Microsoft Word, has no serifs, whereas the 
letter in the this ubiquitous Times New Roman serif 
typeface, has serifs on either end: “I”.)

We don’t want something common and plebian like 
Arial, or even the more-common Microsoft Calibri that 
is used as a default text typeface by Microsoft Word. 
We want a sans-serif typeface, in the expectation that, 
unlike this document, people will match it with a com-
mon serif typeface such as Times New Roman, or better 
the serif typeface Georgia that Microsoft supplies as a 
default serif typeface. While Microsoft Word’s default 
of Calibri for both headings and text is reasonable, a 
more professional approach is a sans-serif typeface for a 
title heading and then a serif typeface for text and text 
headings, so we recommend you use Minion (which is 
what this Guide uses for text), Georgia or Times New 
Roman for the body of letters or other documents, not a 
clashing sans-serif font such as Calibri.

Selecting typefaces is notoriously controversial and 
many have strong preferences. In this case, we looked 
at the title/heading typeface used in the most famous 
modern book on typography: Robert Bringhurst’s 
Elements of Typography. It is Scala Sans and we have 
used it for the headers in this document and for the 
stationery and Internal document headers on the next 
page. Microsoft Word templates for the stationery, and 
for internal documents such as the agenda on one of the 
following pages, are available in the ASRC Archive, the 
Admin section, Branding subsection, and specifically in 
the Source Documents sub-subfolder.

It is not available freely online, but must be pur-
chased. This makes it less common which is one of the 
reasons for choosing it for branding. The following 
weights are used in ASRC documents:
•	 FF Scala Sans Pro Regular 
•	 FF Scala Sans Pro Italic 
•	 FF Scala Sans Pro Bold 
•	 FF Scala Sans Pro Black

http://archive.asrc.net
http://home.asrc.net
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The following weights are not used in ASRC docu-
ments, which decreases the purchase cost:
•	 FF Scala Sans Pro Light 
•	 FF Scala Sans Pro Light Italic 
•	 FF Scala Sans Pro Bold Italic 
•	 FF Scala Sans Pro Black Italic 
•	 FF Scala Sans Pro Cond Regular 
•	 FF Scala Sans Pro Cond Bold

Award Certificates 

Process

In 2021, we standardized on a process and design 
for award certificates. This make it less painful and 
time-consuming for the Secretary. It also provides 
awardees with more professional-looking certificates. 

With some prep work, all it takes for the Secretary to 
print off certificates is:
•	 A computer with Microsoft Word 
•	 A black and white printer 
•	 The three Microsoft Word templates (available on the 

ASRC Intranet/SharePoint site; the text is reproduced 
below without full typography and line spacing):
	· Years of Service award:

On 1 January 1000, the ASRC recognizes  
John Doe 

for 
10000 years of service 

in support of ASRC activities and in service to those 
missing or injured in the outdoors

	· Outstanding Achievement Award:
On 1 January 1000, in recognition of support of 

ASRC activities and aiding those 
missing or injured in the outdoors, 

the ASRC hereby confers on
John Doe

the ASRC’s Outstanding Achievement Award

	· Fellowship
On 1 January 1000, in recognition for a life of service 

supporting ASRC activities and aiding those 
missing or injured in the outdoors, the ASRC elected

John Doe, FASRC
a Fellow of the ASRC. Fellowship and

the FASRC honorific are for life.

•	 A supply of certificate blanks
•	 A supply of certificate holders to protect the certifi-

cates during handling, transportation and/or mail-
ing. Paperplan dark blue certificate holders through 
amazon.com are cheap and adequate to the task but 
the brand doesn’t really matter.

•	 An embosser with the ASRC logo for the foil seals 
to be applied to the certificates (obtained 2021, and 
given to the Secretary)

The Secretary, or anyone with a reasonably high 
resolution monochrome printer, then uses the Microsoft 
Word templates referenced above to create a new Word 
file, insert the date and name of the awardee, and print 
on the prepared blanks, as described below.

The Years of Service awards do not require an explan-
atory letter. The Outstanding Achievement awards and 
Fellowship awards should have an explanatory letter, 
this can come from the Chair or the Secretary. 

Preparatory Work

The prep work to prepare for printing the certificates is 
as follows:
•	 We got the embosser through Staples (the big-box 

store). The embosser ASRC line logo is in the ASRC 
Archive, Admin > Branding > Source documents, 
and is 2018-01-14-New-ASRC-Logo-Line-Art.ai and 
2018-01-14-New-ASRC-Logo-Line-Art.pdf.

•	 We buy the Geographics 39452 Parchment Paper 
Certificates, 8-1/2 x 11, Optima Green Border. These 
are available at Staples stores and through amazon.
com. They include a gold-toned foil seal than we can, 
after the certificate is printed, apply to the certificate 
and then emboss with the ASRC embosser.

•	 We run those Geographics blanks through a high-res-
olution color laser printer and add the ASRC name 
and logo, and the name and a scanned signature of 
the current ASRC Chair. A PDF template for printing 
the name and logo and Chair’s signature is available 
on the ASRC Intranet/SharePoint site; it is called 
ASRC-Certificate-Signature-and-Logo.pdf. We use 
the certificate preprinted paper and this PDF to pre-
pare a stock of these blanks for the Secretary. 

•	 When the Chair changes, we need to change the 
signature. This requires updating the InDesign file on 
the ASRC Intranet/SharePoint site; it is called ASRC-
Certificate-Signature-and-Logo.indd.

•	 The process for preparing a transparent signature 
from a scanned signature is as follows:
	· Scan or import handwritten signature into 

Photoshop as grayscale or RGB AT 300 DPI
	· Save as PNG; if layer shows up as Index: Image > 

Mode > grayscale or RGB
	· In Layers Panel, double-click Background to turn 

to Layer 0
	· If need to (probably do): Image > Adjustments 

> Levels > move midlevels to the R to make the 
signature darker

	· Clean up signature with brush tool if needed.
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	· Go to Channels Panel.
	· Control-click the RGB or gray channel to select the 

background. 
	· Click Delete to make the background transparent.
	· If the signature line is too thin, in the PNG, select 

Filter > Other > Minimum (radius 1, or 2 if need to 
make thicker)

	· Save and then drag and drop this PNG into the 

InDesign file to replace the previous Chair’s 
signature.

	· (Pro tip: you can save the transparent-background 
PNG as a transparent-background PDF and then 
use this in Adobe Acrobat as a Stamp to sign 
documents, not electronically, but with a simulated 
manual signature.)
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[Date] 

Reply to: [Reply to Address, no name as should be at bottom] 

[Inside Address] 

 

[Re: (optional)] 

 

Dear [Addressee First and Last Name]: 

[Text] 

 

Sincerely,  

[Your first and last name, your ASRC title] 
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BOARD OF DIRECTORS MEETING AGENDA 

[Meeting Date] [Meeting Location or Phone Conference]  

Dial-in: meet.google.com/bmcujvsdjm (preferred) or 561-614-0036 418707422# 

[Planned Start and End Times] 

I. Call to Order 

II. Participant Roll Call 

III. Approval of Minutes 

IV. Officer Reports  

a. Chair/Vice-Chair 

[Simply hitting Enter after a heading will enter text, in Normal Style. 

As shown here with spacing for the next paragraph.]  

b. Secretary 

c. Treasurer 

d. Credentialing Board Chair 

e. Conference Training Officer  

f. Conference Operations Officer  

g. Information Technology Officer  

h. Others 

V. Unfinished Business 

a. Item 1 

VI. New Business 

a. Item 1 

VII. Good of the Order 

VIII. Adjourn 
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BOARD OF DIRECTORS MEETING MINUTES 

[Meeting Date]    

[Meeting Location or Phone Conference]  

[ Start and End Times] 

I. Call to Order 

II. Participants. 

Voting members in bold. Via teleconference in italics. If some other Group is primary name in 
(parentheses) 

Allegheny 
Mountain Rescue 

Group (AMRG) 

  

Blue Ridge 
Mountain Rescue 
Group (BRMRG) 

 

Maryland Search 
and Rescue 

(MSAR) 

 

Mountaineer Area 
Rescue Group 

(MARG) 

 

Northwest 
Pennsylvania 

Canine Search and 
Rescue 

(NWPAK9SAR)  

 

Remote Support 
Corps (RSC) 

 

 Search and Rescue 
– Ohio (SAROH) 

 

Shenandoah 
Mountain Rescue 

Group (SMRG) 
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III. Approval of Minutes 

IV. Officer Reports  

a. Chair/Vice-Chair 

[Simply hitting Enter after a heading will enter text, in Normal Style. 

As shown here with spacing for the next paragraph.]  

b. Secretary 

c. Treasurer 

d. Credentialing Board Chair 

e. Conference Training Officer  

f. Conference Operations Officer  

g. Information Technology Officer  

h. Others 

V. Unfinished Business 

a. Item 1 

VI. New Business 

a. Item 1 

VII. Good of the Order 

VIII. Adjourn 
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Meeting Sign-In

First N
am

e
Last N

am
e

Voting  
(C

ircle)
C

all-In?
(C

ircle)
Prim

ary G
roup/

C
orps

Secondary G
roup/C

orps

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

Y    N
Y    N

APPALACHIAN SEARCH ANd RESCUE CONFERENCE
P.O. BOx 400440  ♦  Newcomb Hall Station  ♦  Charlottesville, Virginia 22904  ♦  asrc.net

Date:
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Commercial Blank Certificate

Commercial Blank Certificate with ASRC Name, Logo and Chair Signature Added

SAMPLE ONLY
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Document/Publication Format  

Format 

The governing documents and publications of the ASRC 
are, and should be, formatted and styled as illustrated 
and explained in this Branding and Publishing Guide. 
You can see the more examples of formatting and style 
in all the PDF documents and publications posted at the 
ASRC website. 

If you have access to Adobe InDesign, you can see 
the detailed Table of Contents styles, Character Styles, 
Paragraph Styles, Object Styles, and Master Pages that 
create these formats in the InDesign files that create 
those PDFs, including this one. These are available in 
the ASRC Microsoft Teams folders for the Publications 
Committee. 

Most of the details of how to use these styles in 
InDesign are laid out in the Technical Details section, 
below. 

InDesign 

All ASRC public-facing governing documents and 
other publications are now formatted and published, 
whether in PDF or print, in Adobe InDesign, currently 
the leading publishing software. Internal documents are 
usually in Microsoft Word format for ease of updating, 
using the headers provided elsewhere in this Branding 
and Publishing Guide. 

We use InDesign rather than Microsoft Word or 
Publisher. Why? 

InDesign is much more sophisticated and can 
produce a much more professional looking document 
than Word or Publisher. Documents produced from 
InDesign, with the formatting shown in current ASRC 
documents and publications, and for which the instruc-
tions to format them in InDesign follow, are also easier 
for readers to use than those produced from Microsoft 
Word or Publisher. That’s because, among other things, 
they have excellent Table of Contents which produce 
clickable links in published PDFs. They also have 
headers that make it easier to find a particular section or 
subsection. 

InDesign is designed by and for publishing profes-
sionals. That means it’s harder to learn than Word, but 
that output is much better in many other subtle and 
not-so-subtle ways. 

Our InDesign formats have many features that may 
not be apparent on a quick inspection, but that make 
the document look more professional. One example: all 

of the text is laid out on a 12-point grid: the vertical dis-
tance between all of the text, both body and headings, is 
12 points or a multiple of 12 points (1/6” or one pica). 

Explaining further details of the superior formatting 
provided by InDesign requires learning about pub-
lishing concepts such as leading (not “leeding” as in 
“leading a horse to water,” but “ledding” as in “lead-pipe 
cinch”), kerning, tracking and optical margins. That is 
beyond the scope of this Branding and Publishing Guide. 
Further information on these topics is best found in 
Robert Bringhurst’s book The Elements of Typography, 
the most respected book on typography. Adobe hired 
Bringhurst to help with InDesign and we have consulted 
with him about InDesign issues in the past.

Having the ASRC documents in InDesign does 
require that we have (a) at least one person who has 
InDesign, (b) this person is willing to learn how to use 
it, and (c) this person is willing to do the final format-
ting for the governing documents and publications. 
Given formats are now fairly stable, after much develop-
ment and subsequent tweaking, it’s pretty much (a) and 
(b) that are issues. 

 To make it easier on whoever is serving as ASRC 
Publisher (the ASRC member/members with InDesign 
and the knowledge and time to use it), the InDesign file 
for this Branding and Publishing Guide contains all the 
paragraph and character styles used in all of the ASRC 
governing documents and publications. 

That’s because the InDesign file of the Branding and 
Publishing Guide is the Style Master in the InDesign 
Book Panel for the ASRC documents and publications, 
and a change to a paragraph style or character style in 
this document can and should, with a few clicks of your 
mouse, propagate to all other ASRC governing docu-
ments and publications. Not all of the styles are needed 
for every document, but having them the same in all 
documents, and having them available in every docu-
ment/publication to invoke when needed, goes a long 
way to keeping our documents/publications looking 
similar and professional. 

However, this powerful feature can have side effects 
in other documents. One example is that improving 
(changing) a style in the Branding and Publishing Guide 
and propagating this change to other documents might 
move text in those other documents around and getting 
page numbers out of sync with the Table of Contents. 
You might need to check the Table of Contents for other 
documents and update them in InDesign with [click in 
Table of Contents] > Layout > Update Table of Contents. 
That’s also the way you updated the Table of Contents 
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after editing the text, which may move some of the 
pages around.

“One-Pagers” and Book Panels  

The ASRC is developing a series of “one-pagers,” which 
are a single sheet of paper, printed front and back, that 
provide “just-in-time” training. The inspiration was Carl 
Werntz’s idea in 2016 of one-pagers on safety topics, 
and the first one-pager was one he did on hydration, 
primarily for hot-weather operations. If we go back 
further, Keith Conover produced an ASRC “Searcher 
Information Sheet” in 1975.

These one-sheet, two-page branded handouts are 
informally called “One-Pagers” as “One-Sheeters” is just 
a nonstarter. 

We also decided that these would be authored by 
the ASRC Publications Committee as a whole, collab-
oratively. Thus, even if one member takes on the major 
responsibility for shepherding a one-pager through to 
completion, they don’t have a byline to credit that par-
ticular member. However, they should get credit for any 
illustrations they provide, if they wish. 

The One-Pagers contain a small chunk of useful 
information. But only as much as can fit onto one sheet 
of paper, in a fairly large type face than can be read 
outdoors in poor lighting. While they can be used in 
training sessions, they an also be used as just-in-time 
training at a search base. If we can’t fit it onto a one-
pager, we’ll find some other way to communicate the 
information. But we can do a lot with the one-pager 
format.

These one-pagers might be used outside the ASRC, 
and even within the ASRC provide an opportunity 
to show the value of the ASRC to Group members. 
Thus, branding and professional design are major 
considerations.

There is branding on both front and back:
•	 A relatively small ASRC logo. This is a vector version, 

rather than a raster bitmap, so it will print at full 
resolution of the printer or typesetter. 

•	 A large but subdued (25% gray tint) “Appalachian 
Search and Rescue Conference” and the web address 
at the bottom. 

There are design elements that contribute to a profes-
sional look:
•	 Typefaces: Scala Sans (we use the Scala Sans Pro ver-

sion that comes with an InDesign subscription and 
not the Scala Sans OT version that can be purchased) 
and Minion Pro, as also used in other official ASRC 
documents styled using this Branding and Publishing 
Guide. 

•	 Main text set in 14 point on an 18 point grid: bigger 
text and wider leading (spacing) than in govern-
ing documents, for ease in reading in poor light. 
Eighteen point spacing between paragraphs, ditto. 
Everything lines up nicely on an 18-point grid, which 
nobody is conscious of but is an important design 
element: looks more professional, easier to read. All 
Paragraph Styles, including the various headings, are 
set in the Align to Grid option in the Indents and 
Spacing options, to All Lines. This makes sure all 
text aligns to this grid. This “All Lines Align” setting 
is the case with this paragraph’s text in the Branding 
and Publishing Guide, though this text is smaller 
(10 points) and has tighter leading (12 points) and 
paragraph spacing (indents or bullets but no addi-
tional space). The only exception is the fine print of 
the Creative Commons license, in which case it’s set 
to Align to Grid: First Line Only None.

•	 The blue text highlighting color matches the blue of 
the star of life in the ASRC logo. It should print fine 
and be legible on monochrome printers, but looks 
even better when you see it on a computer screen or 
a version printed in color. 

We want to make sure the styles in all of the one-pag-
ers are precisely the same. Doing this manually is very 
time-consuming, But InDesign offers a feature to syn-
chronize the styles in a group of documents. This func-
tion uses a file to list the documents in the group, and to 
designate a single master document (the Style Source); 
you can then sync the styles in the Style Source with all 
the others. Thus, for the one-pagers, you can just make 
a tweak a style in the Style Source, in this case ASRC-
Generic-One-Pager-Template.indd, and then with a 
press of a button sync this to all the other one-pagers. 

The interface for this function is called a Book Panel, 
because it is used mostly to coordinate styles and page 
numbers across book chapters that are in separate 
files. The Book Panel is really a file that points to other 
documents. To open a particular Book Panel, you need 
create (File > New > Book) or open (File > Open) the 
appropriate file, which has an extension of .indb; the file 
for the one-pagers is One-Pagers-Book-Panel.indb.

Important: before adding any documents to a Book 
Panel, turn off automatic pagination, or InDesign will 
slow down trying to update the page numbers in all the 
documents. (Which will also disrupt any page number-
ing if we use this for documents other than the one-pag-
ers.) To do so, Book Panel > [top right menu button] 
> Book Page Numbering Options… > Automatically 
Update Page & Section Numbers > [uncheck]. 

One advantage of the Book Panel is that it provides 
an easy way to group files so they are easily accessible in 
InDesign, and some people use a Book Panel solely to 
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organize InDesign files. For the one-pagers, it certainly 
makes it easy to access them. 

We are starting to use this Book Panel approach to 
synchronize styles across all the ASRC governing docu-
ments as well. 

Governing documents that might be hole-punched or 
stapled or bound have one-inch margins. The one-pag-
ers have half-inch margins as their primary purpose is 
to be handed out as disposable one-sheet documents as 
needed. 

The title appears on the second page, but deempha-
sized by a 50% tint of gray, and no color as on the front 
page. The One-Pager template appears on the next two 
pages.  

There are formatting options in the InDesign source 
files that help with the formatting, such as grids set to 
6 picas to the inch rather than the InDesign default of 
8 eighths to an inch, and some text frames (those with 

the fine print) having the default text alignment set to 
Bottom to preserve the block-like headings on the two 
pages, framed by white space.  

The text for one-pagers must fit in the alloted space. 
To preserve branding and professional appearance, we 
will not decrease text size or spacing to fit in more text. 
If the text (and any diagrams or other graphics) won’t fit 
in the alloted space, then it’s too much for a one-pager. 
Longer text might be appropriate for other publications 
such as a White Paper.

There is a bit of flexibility in the one-pager design. 
Many of the one-pagers have a single top left, 1”x1” 
thumbnail graphic (same size as the ASRC logo on 
the right) which, along with the title, identifies the 
topic of the one-pager. The Hypothermia and Frostbite 
one-pagers have bullets that look like snowflakes. Other 
deviations from the template should be discussed and 
approved by the Publications Committee. 
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Appalachian Search and Rescue Conference  ♦  asrc.net 

Generic One-Pager Template 
(second line only if needed)

Version 1.0   4 February 2018

Unt Aut Volupta 

Cum et od et anderumet et, simet eum fugiasp 
ictianimodis ex est odignis doloria conem facia 
ditat est quiatur, cum que eos volupta tempor 
rerchit, ipiet ad es audae quibusc ieniet volor-
emquam, sanim suntias exerum sa niasped ex-
ceprorpore idigenti ipis as expelibusdae etum 
imus, coriorempos erion num es que solendi 
am dicipsum latia consed et etust, offic tem 
dolum nullesequia enda et volorit lam nist, to 
que dolorae velibusapid eum serrum qui archili 
ataturem veles nihil essitio. Ficipsa que dolorec 
tatecae peribus, quoditate cone lacculpa por-
estium di dolupti dus re nihit ut velligni cum 
quo vendae niendeb itatior soluptint iundia 
nis est qui ni consercia cus sint, sequi sinienda 
velignam, eat.

Gendia nis idem ideliquatem ipsus utem aut 
recte dolorer ibusam res et harumquatur?

Ati blaborepre nonectium qui officat ioribus, 
susciet int apis essunt quat qui ratur, quis et 
elisci consequia soluptatur accuptaere dolo-
rae consectiant mi, occusam, volum ea pre ne 
nonet ea dis mossit reniae porem excea volut 
mod modipsam dolorest aut quam facia abor 
aut il est occum idictiu rerunt alit liquasseque 
doloriat pero berferi orporro quaspiciis autem 
net pe eos am, quidebis ipsus rendebit pernatu 
restis volest, se plicillenda ium adi re nobit 

voluptatium delectiorrum quae repudis essi-
tia ssitio volorit, ium fugia porepro velis re pa 
quatur autaeprero volorem fuga. Urit ommo 
quis aborenihic tenihit et et vellecu llitat.

Faciet Hiliqua

Ut ullibus aeprae paribus acea voluptatis ant 
velestio dem res rerspelitia nihictatur rempe-
les alia quam aut lam eseque quiatiae sum re, 
ipsam, offic te re enditatquo tem doluptatur?

Ga. Dem et et, as quam que vercimin core 
secus aut rerchil ipienim agnimpos nus vellent 
rehendiandi blamus.

Optate mos eaqui omnis dolorio et eum lis is 
quam faccae vel im volo eum fuga. Nam arum-
qui que liqui omnitin eatur, cupti reperio to 
officiendi incias mi, sequas et adipis solor adit 
elenimp orrum, sequi doleseq uistiist porem 
re entiusc ilitatius di am quam, santiande num 
fugita nobit eium labo. Nequi dolupta volore-
pudam nit et quibusam con porporemquam 
quoditiatem quatet que conseque et assimagni-
as sinctur? Bitin cust, iunt repe sersper natur? 
Quisci consed quidusant de veliquation nisita 
cus es nosa dolorporero to beatempor mi, sen-
dani hitemos secuptatur, ant, cum ratquunt.

Is estiis doluptatia dolupta sinveni ium aut 
aut eate es perum cullorectur simaxim eiunt, 

continues next page…
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Generic One-Pager Template
(second line only if needed)

Appalachian Search and Rescue Conference  ♦  asrc.net 

quuntur? Vid qui de doluptis repudae caborro 
vidigni hicitat ecaectasi nonsectemod magnate 

Exersperem Dolectemquo Beat 

• Volorat urissimagnis quam cus rest soluptae 
lanihilis estis aut rem il et vellent dolorro 
magnist quas sa archiliti dunt.

• Cae delloratet in ratiora nis cuptasped quo-
diam fuga. 

Nem et ulpa niae volorep tatiscia ex evenduc 
iendanda dus ea cum es aut iur re apis ipicate 
ntibus ma doluptiam imus, volor simodi der-
ae conseque omnimusam hitem harum quam 
qui quasincid modi nos errovide explaborem. 
Optatur sit pa ducil ium res sentem harundia-
tur sam et et, voloreh enihil eaque aut faccae 
vernam incitibus adiscia nias eos et ut que 
dolore venis exerit vent explitat voluptaepra 
volum as id eatur re et veriaes dolupta quatqui 
busam, santias enis mi, et lam, comni te conse-
cesequi tes ditat est, quiduntur aliae nus.

Hendelic te corae ene eatia sunt et vendelicium 
quibusam audias et atiscima alis int.

Nulparum eiciur autae volupta 
quunt

Aquo cuptatet occumque cus escit voluptis si 

sim sam qui doluptatia vendicitatem culparcius 
denis im labo. Sed quo voluptas volorecti offi-
cabore nis magnias pediscim sa aut is etur rem 
simus imet et et volore voluptatia velest aut 
magnimp orenitis etum volorem labo. Assum 
debis aut earit, suntin culluptata dicium quas 
sequi dolupta tuscita tiaspernatus explitatem 
fugia ius.

Ecabor suntibu sdaerio nsequi quost, ipicips 
anderoria cuptasperi debis amus maionseque 
sapediae molo offictes a sum voluptatione 
voluptat alisite mposti berchilit ulparum fuga. 
Itas non provid mos dolori ad eic te ellabo. 
Escius si rem entio offici sundebist, quaerroris 
alis mi, sequam quo quo magnimi lluptat em-
poressitem assit lantem nitia dolorerum solor-
emod molore pro bearum fuga. Ed molorum 
esti re voloris ped quataspidis atem volorerit 
lit eum natqui ut aut maio millupti quis et rem 
harum eatur, corrunt volut ommolor molo 
culpa consenis excestet volupid erepremquos 
as simintium eos voluptatibus simus, officiet 
a voluptas re, od magnia perferit quaecest, ut 
od eium rendio iderspis et, quaepra corepro 
ratiisi taestia paria presequ iaeprat ecabori 
blaboreped quossi ut utem fuga. 

Maio maiorec erferspicia cuptatetur, conet ex 
evel ea sendelest ut quame sandic to dunda 
volorestis quis nusapid eostiss itintur?

…continued from previous page

This work is licensed under the Attribution-ShareAlike 4.0 International 
License (CC BY-SA 4.0) . To view a copy of this license, visit https://
creativecommons.org/licenses/by-sa/4.0/ or send a letter to Creative Com-
mons, 171 Second Street, Suite 300, San Francisco, California, 94105, USA.

Illustrations by asdf asdf.  
Reproduced with permission. 
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Website
The ASRC website is an important ASRC “publication.” 
As with anything dealing with computers, there are 
many technical details that are necessary to support the 
design of the website.

Hosting 

We use DreamHost to host our domains and host 
WordPress for us; the account is a free non-profit one. 
The primary email of record is treasurer@asrc.net to 
make sure that our bills for hosting get paid promptly 
and that our website doesn’t go down. We can add 
additional secondary emails, which you may have to 
do to have an email conversation with DreamHost 
tech support about the site. It is appropriate to ensure 
that our Information Technology Officer and Deputy 
Information Technology Officer aliases are listed as 
secondary emails.

Website Administration Dashboard 

Access to the ASRC website administration dashboard 
is at:

http://www.myasrc.org/admin/

Despite the domain name, this gets you to the asrc.
net WordPress administration dashboard. The reason 
for this, is that we first set up the website at myasrc.org 
and then later mirrored it to asrc.net. This means any 
changes to the file structure must be made at myasrc.org 
rather than at asrc.net.

Passwords for this and other IT infrastructure is kept 
in a secure location and only accessible to those with a 
need to know.

Website Design and Structure 

The ASRC website (http://asrc.net) is managed as a 
series of pages using WordPress. Although WordPress 
is thought of as a way to create a website with a series of 
dated blog entries, the ASRC, as with many other orga-
nizations, uses it without creating any dated blog posts. 
WordPress is also a popular way to create website using 
WordPress “pages” rather than WordPress “posts.”

A WordPress “theme” gives the website its look and 
feel and can provide many other configuration options. 

In web parlance, “responsive” or “responsive design” 
means a website that can be easily viewed and navigated 
on a big PC monitor, a tablet, or a cellphone. There are 
different ways to make a WordPress site responsive, but 
the way that the ASRC website is responsive is through 
a responsive Wordpress theme called ASRC which is 
a customized version of a free WordPress responsive 
theme from CyberChimps. 

This works by disabling the standard WordPress 
editor and home page design that uses “blocks” of infor-
mation, and instead, creating a custom web page using 
“widgets.” You access the home page thus: 
•	 Login to the asrc.net WordPress administrative dash-

board at http://www.myasrc.org/admin/
•	 > Dashboard
•	 > Appearance
•	 > Customize

To add material to a page, you have to add a widget. 
The only way to see the “Add a Widget” button is to start 
editing one of the existing Widgets and scroll to the 
bottom.

Document and Publication Files 

At asrc.net, we have two subdirectories (subfolders), one 
each for our governing documents and publications. 
The files in these subdirectories are the current versions 
of the publications. We store older versions in the ASRC 
Archive.

Having the files in these subdirectories means that 
you can reference them by a short URL. For example: 
http://asrc.net/doc/ASRC-Training-Standards.pdf. 

The naming convention for these files: ASRC-[short 
name of document]. Unlike in the Archive (for the 
Archive naming format, see the ASRC Admin Manual 
at: http://www.asrc.net/doc/ASRC-Admin-Manual.pdf), 
there is no leading date, and no version number. All 
spaces are replaced with hyphens.

Within each subdirectory, there are a few files that, if 
someone browses the subdirectory, give a better listing 
of the files than the standard one. These are:
•	 .htaccess
•	 .error.php
•	 .index.php
•	 .style.css
•	 .sorttable.js

Access to these subdirectories are via FTP:
•	 FTP protocol: SFTP
•	 FTP host: ftp://grantspass.dreamhost.com 

http://www.myasrc.org/admin/
http://asrc.net
http://www.myasrc.org/admin/
http://asrc.net/doc/ASRC-Training-Standards.pdf.
http://www.asrc.net/doc/ASRC-Admin-Manual.pdf
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•	 FTP username: asrc_admin
•	 FTP password: [in password file]
•	 FTP port: 22

asrc.net/pub

“pub” is for publications designed for general use by 
the SAR public and available to the general SAR public 
as well. These documents are under the purview of 
the ASRC Publications Committee. These include the 
Training Guide and the One-Pagers.

asrc.net/doc

“doc” is for our governing documents, which are here 
primarily for ASRC member, but available to anyone 

who wants to see them. These are under the purview 
of the ASRC Board of Directors or membership. These 
include Bylaws, Operational Guidance Manual, and 
Training Standards.

Web Fonts  

Scala Sans and Minion, our standard fonts for printed 
and PDF materials, are not available as web fonts. 
However, we approximate them on our website with the 
following, which are available freely for download:
•	 For headings we use Source Sans Pro - https://fonts.

google.com/specimen/Source+Sans+Pro 
•	 For text we use Crimson Text - https://fonts.google.

com/specimen/Crimson+Text.
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Slides  
Slide presentations benefit from a professional appear-
ance and consistency as much if not more than docu-
ments. Slide shows go back hundreds of years, to 17th 
century magic lanterns. Thirty-five millimeter (35mm) 
photographic transparencies came into use in the 1930s, 
and by the 1950s people had started boring friends and 
family with hours of blurry vacation slides. Slide shows 
really came into routine use for education and corporate 
presentations with the advent of the Kodak Carousel 
slide projector in 1965. By the 1980s corporations had 
realized realized the power of slide presentations and 
had full-time staff devoted to preparing slides for 
sales, executive presentation and educational lectures. 
Standardized backgrounds with corporate or institu-
tional logos became required. 

Microsoft’s introduction of PowerPoint in 1990 
sounded the death-knell for the Carousel and 35mm 
slides, and despite competition, powerpoint has become 
a synonym for a computer-based “slide” presentation. 
We provide PowerPoint masters as all other presentation 
programs will accept them.

Even in this day of cheaper, lighter and brighter LCD,  
LED and laser projectors, the emphasis on corporate 
branding for “slides” continues, and for good reason. 

Colors

There is good evidence that black text on white is the 
most readable on a computer screen, but with a pro-
jection in a relatively-dark room the glare from the 
projected white background may cause headaches. The 
same evidence shows that white text on a black or gray 
background is quite readable on a computer screen. 
However, viewing a projected image across a darkened 
room is not the same as reading text in a computer 
browser or a piece of paper right in front of your face.

Expert opinion says that for projected slides, a bluish 
background with white or yellow text is probably best. 
This provides the best legibility (of colored backgrounds 
and texts) and the least eyestrain. The combination of 
red and green, in particular, causes a strobing effect and 
is famous for nauseating viewers. 

There are also psychological arguments for using a 
bluish background. A blue background tends to project 
calmness and professionalism, more so than a black 
or gray background. A blue background also contrasts 
perfectly with the orange around the edge of the ASRC 
logo. We could have used a plain blue background 
or a gradient with the ASRC logo in one corner. But 
the backgrounds we chose, one for title slides and a 

differnent one for main slides, provide a distinct appear-
ance, and one of the goals of branding is to provide 
something that looks distinct.

Guidelines for Slide Presentations

In his essay The Cognitive Style of PowerPoint, Yale pro-
fessor Edward Tufte explains how PowerPoint crashed a 
space shuttle (and now that we have your attention) can 
easily be misused. Some of the most important lessons 
there include:
•	 A slide presentation can foreshorten a complex sub-

ject and leave out important details.
•	 Projected slides have a low resolution compared to 

a piece of printed paper or even a lower-resolution 

2

Search and Rescue Objectives

• Safety Rules
• Don’t get separated from your pack
• Don’t get separated from your pack
• Don’t get separated from your pack
• Don’t get separated from your pack
• Don’t get separated from your pack
• Don’t get separated from your pack
• Don’t get separated from your pack
• Don’t get separated from your pack

Slide masters licensed under a 
Creative Commons Attribution 4.0 

International License by the ASRC .

1Presentation [licensed under a Creative 
Commons… ] | [copyright ©] by [your 

or Group name] | ]

Search and 
Rescue 

Joe Rockjock,
Generic Mountain Rescue Group

4/3/19

https://en.wikipedia.org/wiki/Magic_lantern
http://www.laurenscharff.com/research/survreslts.html
https://www.edwardtufte.com/bboard/q-and-a-fetch-msg?msg_id=000082
https://www.edwardtufte.com/tufte/books_pp
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computer screen in front of your face.
•	 A slide presentation has to be linear and inflexible; 

it’s hard to jump around based on interaction with 
your audience, which makes you unwilling to inter-
act with your audience.

•	 Tufte is perhaps the world’s leading expert on the 
presentation of data (just the titles of some of his 
books should provide a clue: The Visual Display of 
Quantitative Information; Envisioning Information; 
Visual Explanations: Images and Quantities, Evidence 
and Narrative; and Beautiful Evidence.) He points out 
the deficiencies of PowerPoint’s data displays.

•	 Perhaps most importantly, Tufte has issues with 
making the audience read text on a wall. He doesn’t 
think it’s an effective teaching tool. He recommends 
using PowerPoint to show diagrams, illustrations, or 
photos.

A strictly Tufte-compliant slide show might consist of 
a series of graphics on a black background, broken up 
into sections by a few title slides. We provide a master 
title layout, and a section header layout.  

Although we provide a variety of slide masters, it’s a 
best practice that you should use a totally black back-
ground for the graphics slides. There is no need to have 
the ASRC logo on each slide. The ASRC PowerPoint 
template provides a black-background master with only 
a slide number. 

If your audience needs to know how to spell a word, 
or you need to show some numbers, insert a graphic 
into one of the slide masters that provides a title. But as 
a general rule, it is better to insert graphics into a slide 
with a black background. 

To make a PowerPoint slide show more usable for 
others, without filling the presentation with text for the 
audience to read off of the wall, put detailed speaker’s 
notes in the notes field. 

PowerPoint and other popular presentation software 
offer a mode where you can view the presenter’s notes 
on a laptop while the projector is showing the slide. 
Those who wish to use someone else’s slide show can 
read through the presenter’s notes you’ve entered to 
prepare for the presentation.

Creating Slide Masters

These details on creation are for reference just in case 
someone, someday, needs to create new slide masters for 
the ASRC. 

The background we chose is Crystal Graphics’ back-
ground PowerPlugs BGs 1 B09A.jpg; this is from a CD 
from ~1999. They have many thousands of backgrounds 
available on their website and you can’t find it by 

searching on this name. For the widescreen version, we 
simply trimmed off the bottom of the background.

To make the lettering distinct on the lighter blue 
of the main title slide, in PowerPoint we applied the 
heaviest outer glow of gray to the yellow main title text 
(Home > Drawing > Shape Effects > Glow >[pick the 
bottom gray glow]), and an outer glow of white to the 
title slide subtext. Text for the other slides does not have 
an outer glow, nor does it need it as it’s light on a dark 
background.
•	 A few obscure rules discovered while creating these 

slide masters:
•	 Text Boxes are not Placeholders.
•	 Only Placeholders work in Templates, not Text 

Boxes.
•	 Text that is not in Placeholders won’t show up in the 

Outline view.
•	 You have to add a Placeholder via the menu at the 

top: View > Slide Master, Master Layout > Insert 
Placeholder.

•	 If you want to format text in a Content or Text 
Placeholder, you can’t paste in text from another 
Text Box or Placeholder, you have to insert the 
Placeholder, and then edit the text that automatically 
appears there.

•	 To format text in a Placeholder, you can’t use the 
Format Painter to transfer formatting from another 
slide. You can, however, copy and paste a Placeholder 
(or Text Box?) into the slide, and then use the Format 
Painter within that slide to copy the formatting.

Downloading

Powerpoint templates that you can use to create your 
own ASRC-branded slide presentation are available, in 
both standard (4:3) ratio and widescreen (16:9) sizes. 
Only the standard is shown here but both are available 
at archive.asrc.net > Admin > Branding or at http://
archive.asrc.net/#IDASRC-Admin-ASRC-Branding-.

Overview of Slide Masters

The branding on these slides consists of:
•	 Background: the backgrounds are professional ones 

that contrast nicely with the ASRC logo. There are 
separate backgrounds for title slides and standard 
slides. Please don’t change the background, except to 
use a black background with no graphics for images 
(photos, diagrams and the like). We adjusted the 
original non-title slide background to make it a bit 
darker and have less contrast; note that it seems to 
print darker than it appears on-screen or projected.

http://archive. asrc.net
http://archive.asrc.net/#IDASRC-Admin-ASRC-Branding-
http://archive.asrc.net/#IDASRC-Admin-ASRC-Branding-
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•	 ASRC Logo: a large logo appears at the top left of 
the title slide master, and a small ASRC logo at the 
top left on all the other slide masters. The ASRC 
“Appalachian Search and Rescue Conference“ in the 
official Scala Sans typeface does not appear on these 
slide masters. We think the logo is enough branding, 
and adding text would be too much. 

•	 Text Size: text on the masters is sized to be readable 
when projected on a wall. If you make text signifi-
cantly smaller, people may have trouble reading it. 
Unsolicited advice: If you have the urge to put lots of 
small text on a slide – don’t. Prepare a handout with 
your text, or take the time to verbally explain the 
concept to your audience while showing an image 
without any text, or even just show a black slide. 

•	 Title Slide Master Text Color: the most import-
ant text is in yellow, and we have replaced the old 

standard PowerPoint drop shadow with a contrasting 
outer glow which provides the needed contrast but 
is more subtle. Subsidiary text is in dark blue with a 
white outer glow on the lighter blue background. 

•	 Non-Title Slide Master Text Color: Since the non-ti-
tle slide masters all have a darker blue background, 
the most important text is in a tint of yellow with a 
gray drop shadow. Outline text has a first-level with 
light blue text with a black drop shadow. Lower out-
line levels are in a whitish tint of yellow, with again a 
black drop shadow.    

•	 Text Font/Typeface: The typeface is Georgia, which 
is a typeface that will be found on most computers, 
which is important as PowerPoint cannot embed 
some typefaces. It is a serif face that is reasonably 
pleasant, and we also recommend it for letters using 
the ASRC letterhead. 
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Intellectual Property  
At the March 2019 ASRC Board of Directors meeting, 
we had a long and productive discussion about the 
interaction of copyright and Creative Commons licenses 
for slide or other presentations created by ASRC mem-
bers. We discussed the following points:
•	 ASRC members may wish to include in their 

presentations copyrighted material which they, but 
not others, are permitted to use. An example is a 
figure from a published journal article written by the 
member. Thus, such a member’s presentation should 
bear a copyright by that member. And, the Creative 
Commons license on the slide masters should apply 
only to the slide masters, not to presentations created 
using the slide masters.

•	 The Creative Commons license By-SA used for 
ASRC documents is not appropriate for the ASRC 
slide masters, as it allows others to modify them. It 
should be By, which requires attribution, but does 
not allow modification.

Based on this and other considerations, in April 2020 
the ASRC Board of Directors established the following: 

It is important to have copyright in mind both when 
looking to include someone else’s copyrighted work in 
our work, as well as when authoring, publishing and 
sharing a piece of our own. Copyright law is an exten-
sive and complex field, it varies by where you are in the 
world, and attempting to describe its nuances is way out 
of the scope of this document. Per the U.S. Copyright 
Office, copyright “protects original works of author-
ship including literary, dramatic, musical, and artistic 
works, such as poetry, novels, movies, songs, computer 
software, and architecture. Copyright does not protect 
facts, ideas, systems, or methods of operation, although 
it may protect the way these things are expressed.” In the 
U.S., a protected work does not need to be published to 
be protected and every work is copyrighted by default 
upon its creation.

For ASRC publications, the recommended license 
is Creative Commons Attribution-NonCommercial-
ShareAlike. (CC BY-NC-SA). This would allow anyone 
to take material published under this license, copy, 
modify, and share the content, as long as they give 
appropriate credit to the ASRC, did not use it for com-
mercial purposes, and shared any new derivative works 

under the same license. It is important to specify, when 
the ASRC logo is included in the publication, that the 
Creative Commons license only extends to the content 
and not the logo (which would be protected by trade-
mark, not copyright). To do this, the copyright notice 
should be explicit about what is licensed and what isn’t, 
such as: “The text of and illustrations in this document 
are licensed by the ASRC under a Creative Commons 
Attribution-NonCommercial-ShareAlike 4.0 license 
(“CC BY-NC-SA”). The ASRC name, acronym, logo and 
all other associated marks are protected trademarks of 
the ASRC.”

ASRC authors must ensure that any works included 
in our publications are properly licensed for us to use. 
A few strategies to ensure this include using works 
licensed under Creative Commons, using works that 
are in the public domain, using works in a way that 
complies with Fair Use, or obtaining explicit written 
permission by the copyright holder and ideally, if dif-
ferent, the author of the piece in question as well. When 
available, look for specific instructions on the permis-
sions page of the websites of the publishers of material 
you would like to use. It is important to keep in mind 
that the first and last of these suggested strategies (some 
Creative Commons licenses, or obtaining permission to 
use copyrighted material) may not be compatible with 
the Creative Commons license recommended above, 
in which case the publication must be released under a 
license that is compatible with the permissions granted 
for the works being included. In some cases, this may 
even mean disallowing any reproductions or modifi-
cations of the piece we are publishing. When in doubt, 
leave it out! 

For more information:
•	 US Copyright Office - https://www.copyright.gov/
•	 Copyright Basics - https://www.copyright.gov/circs/

circ01.pdf
•	 Copyright & Fair Use - https://fairuse.stanford.edu/

overview/
•	 Creative Commons - https://creativecommons.org/
•	 Copyright Law In 2020 Explained In One [Very 

Long] Page: https://www.whoishostingthis.com/
resources/copyright-guide/

https://www.copyright.gov/
https://www.copyright.gov/circs/circ01.pdf
https://www.copyright.gov/circs/circ01.pdf
https://fairuse.stanford.edu/overview//
https://fairuse.stanford.edu/overview//
https://creativecommons.org/
https://www.whoishostingthis.com/resources/copyright-guide/
https://www.whoishostingthis.com/resources/copyright-guide/
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Document Collaboration Basics 

Recommendations 

These recommendations will likely change without 
much notice as technology changes. But as of the par-
ticular second this section was typed, we think the two 
best methods for ASRC document collaboration are:
•	 Documents with a significant number of graphics 

and tables, such as Essentials for Search and Rescue 
and some of the One-Pagers: Use Adobe InDesign 
Share for Review as described below, for review and 
markup/sequential collaboration. 

•	 Documents that are mostly text, like the Bylaws or 
Admin Manual: export Microsoft Word files from 
InDesign and put them on the ASRC’s OneDrive 
folder for co-editing/real-time collaboration, as 
described below.
The table “Document Collaboration Systems” on 

page 31 provides an overview of different document 
collaboration methods suitable for the ASRC. As these 
collaboration methods mature and improve, we will 
update, and it is likely we will want to change our choice 
of collaboration systems.

Background 

For over 45 years, the ASRC has been a wide-area 
network of Groups and people collaborating on projects 
of joint benefit. Given technological changes over the 
decades, and now Covid-19, our methods of collabo-
ration have gradually morphed from mostly in-person 
meetings to mostly virtual meetings for collaboration. 

A major portion of our collaboration is to review and 
update our governing documents and other publica-
tions. Over the past 45 years, our methods for doing this 
have evolved from 
•	 Mailing photocopied documents for review, to 
•	 Emailing Word documents, to 
•	 Emailing commentable PDF files, to
•	 Google Docs, to 
•	 Reviewing and commenting on commentable PDFs 

online using Adobe Document Cloud, to
•	 InDesign Share for Review online. 

While these all incrementally sped up and improved 
the quality of our document review and updates, the 
process can improved further. There are many ways to 
collaborate on documents; they change, and new meth-
ods are created, almost monthly. 

Microsoft Word has always had outstanding com-
menting, reviewing, and redlining/blue-penciling 
(wordsmithing) tools. More recently, we can put a 
Microsoft Word file on the ASRC Microsoft SharePoint 
site; multiple people can use all of those tools on the 
online version of the document at the same time, and 
see each others’ comments and edits.

However, getting a Microsoft Word file out of and 
into InDesign are complex and labor-intensive jobs, 
although there are ways to greatly simplify them. (For 
details, see “InDesign RTF Editing in Word” on page 
40.) 

Getting a Google Docs file out of and into InDesign is 
even more labor-intensive and significantly more error-
prone. Unlike Microsoft Word files, we know of no way 
to simplify it.

Getting an RTF file (Rich Text Format, .rtf) out of 
InDesign is just a matter of a few clicks. The problem 
is that when you look at it in Word – Microsoft Word 
understands RTF quite well – it really doesn’t look much 
like the InDesign original. The main problem is that 
many of our documents are in some kind of outline 
format, numbered or just indicated with different-
ly-styled headings. The differently-styled headings show 
up somewhat like the InDesign original, but the outline 
numbers and letters don’t show up properly in Word. 
For Microsoft Word files, there is a way to insert that 
outline number/letter formatting. We are aware of no 
such workaround for Google Docs.

Neither Google Docs or Microsoft Word work at all 
well at editing documents with lots of graphics or tables. 
They need to be produced in a page-design program 
such as InDesign (our choice), QuarkXPress or Affinity 
Publisher.

In the past, by creating this Branding Guide, the 
ASRC Board of Directors voted to have all of our 
external-facing governing documents and publications 
published using Adobe InDesign. This does have great 
advantages in creating more professional-appearing and 
more usable documents, especially those that include 
graphics or tables. However, it makes collaborative 
editing more difficult than co-editing a Google Docs or 
Microsoft Word document.

Types of Collaboration

If you are a lumper rather than a splitter,1 there are two 
paradigms of “collaboration” on documents currently 
1  https://en.wikipedia.org/wiki/Lumpers_and_splitters

https://en.wikipedia.org/wiki/Lumpers_and_splitters
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Document Collaboration Systems

Consideration Exported Word 
file on ASRC 

OneDrive

InDesign Share 
for Review

Emailing  
comment- 

enabled PDFs

PDF in Adobe 
Document Cloud

Google Docs

General comments about 
method

Best commenting and 
proposed edits function. 
Best for documents that 
are mostly text. Requires 
complex behind-the-scenes 
work to produce RTF files 
with outline similar to the 
InDesign original.

Still evolving, but right 
now seems best option for 
documents of any length 
that include significant 
number graphics or tables, 
like this document.

Have experience with 
doing this.

Very little work for the 
ASRC Publisher: export to 
PDF, click a button, and 
copy the link to send to 
people to comment on the 
document. 

Great for real-time collabo-
ration, not good for editing 
existing documents  or 
importing into InDesign. 
Suitable for short chunks 
of text such as motions or 
a couple of paragraphs of a 
document. 

Ease of entering com-
ments/proposed revisions

Very easy Easy Fairly easy Fairly easy Very easy

Ease of integrating edits 
and addressing comments 
in final document (import-
ing back into InDesign)

Easy Extremely easy Hard, have to look at 
multiple commented PDFs 
and reconcile

Fairly easy, can import 
comments from PDFs into 
InDesign

Very hard

People can see others’ 
comments and proposed 
revisions in real time

Yes Yes No Yes Yes

All comments/proposed 
revisions associated with a 
name other than “Guest”

? Can be guest and still 
input name; if register, 
get notifications about 
comment/replies

? Yes ?

Can edit text as a proposed 
revision

Very easily Yes Sorta Sorta Very easily

Can see and act on com-
ments in InDesign

No Yes, no need to import Can import comments 
from PDF into InDesign

Can import comments 
from PDF into InDesign

No

Reps can share further by 
emailing document or URL

Yes Yes Yes, but only by further 
emailing document, not 
URL

Yes Yes

Must/can restrict to 
individual email invite 

No? Optional Can forward by email Optional Optional

Can Password Protect Yes Yes Yes No No

Can wordsmith either with 
a projector or in online 
meeting sharing screen

Yes Yes No? No, as have to save to PDF 
to upload to the Document 
Cloud

Yes

Ease of preparing final 
document in InDesign 

Neither hard nor 
easy, have to do some 
reformatting

Very easy, no  
reformatting needed

Fairly easy Fairly easy Hard

Ease of author/editor 
editing native or exported 
document (PDF or .rtf )

Bad if just raw .rtf (can’t 
see outline numbers); 
if use prepared Word 
template file with styles 
that match InDesign styles 
much better.

Excellent, can work directly 
in InDesign as viewing 
comments. 

Fair Fair Excellent

Can see document in final 
format

Fair, but text only, can’t see 
graphics or tables

Excellent Excellent Excellent Poor

Can edit document and 
still see comments from 
prior drafts

Yes, in the sense that all 
comments and edits can 
be seen until published or 
next clean draft.

No: comments lose their 
connection with the text 
if edited, see text for how 
to edit 

No No Yes, in the sense that all 
comments and edits can 
be seen until published or 
next clean draft.
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available to us: co-editing, which we can also call real-
time collaboration, and review and markup, which 
we can call sequential collaboration. These are both 
explained further in the following sections.

Review and Markup/Sequential Collaboration 

For review and markup/sequential collaboration, some-
one – the ASRC Publisher, or maybe another ASRC 
officer or member acting as an editor – prepares a draft 
of a document and makes it public to solicit comments 
and suggested edits. Review and markup has likely been 
around since the time of Aristotle, Socrates and Plato 
~2300 years ago. Review and markup still works well, 
and we can make it speedier and easier using online 
drafts. The process is:
•	 The editor prepares a draft in InDesign and makes 

it public with an online link and a closing date for 
comments.

•	 People review the document, add comments and 
suggest edits. 

•	 People can see others’ comments and suggested edits 
and respond to them.

•	 Once the comment period closes, the editor prepares 
a new version, and either
	· Presents it to the ASRC Board of Directors or 

Publication Committee for approval, or
	· Presents a new draft for review with a new com-

ment period closing date. 

Review and markup does not allow some co-editing 
options found in Google Docs and Microsoft Word such 
as moving a block of text. However, with review and 
markup, you do get to see the document with graphics 
and tables, the way it will appear in the final document. 
You can’t do this with co-editing in Google Docs or 
Microsoft Word, as they don’t have the page-layout 
capabilities of InDesign that we use to publish our 
documents.

We currently know of two not-too-difficult ways to to 
do review and markup.
•	 First method: Document Cloud PDF. In InDesign, 

from the original InDesign .indd document file, 
create a temporary InDesign .indd file. 
	· Name the temporary InDesign .indd docu-

ment file with a filename starting with the date, 
thus: YYYY-MM-DD-DRAFT-[Document-
Name-and-Revision-Number], such as 
2021-07-02-DRAFT-ASRC-Branding-Guide-1.4.

	· Use the temporary .indd file to create and post 
a PDF online in the Adobe Document Cloud and 
provide reviewers a link to it. 

	· Reviewers can post comments, suggest edits, and 
see and respond to others’ comments online. 

	· Once the comment period closes, import the com-
ments from the PDF into InDesign, and use them 
to edit the original document file and then create a 
new version for approval or additional review and 
markup. 

	· Do not edit the temporary InDesign .indd file. Use 
the temporary InDesign .indd file and its imported 
comments to edit the original file. Editing a file 
with imported comments risks losing the connec-
tion between the comments and the text, making 
it impossible to tell which portion of the text to 
which the comment refers.

•	 Second method: Share for Review. InDesign, from 
the original InDesign .indd document file, create a 
temporary InDesign .indd document file. 
	· Name the temporary InDesign .indd docu-

ment file with a filename starting with the date, 
thus: YYYY-MM-DD-DRAFT-[Document-
Name-and-Revision-Number], such as 
2021-0702--DRAFT-ASRC-Branding-Guide-1.4.

	· In InDesign, from the temporary InDesign .indd 
file, create an Adobe InDesign Share for Review and 
provide reviewers a link to it.

	· Reviewers can post comments, suggest edits, and 
see and respond to others’ comments. Comments 
show up in the temporary InDesign .indd file in 
real time. 

	· Do not edit the temporary InDesign .indd file. Use 
the temporary InDesign .indd file and its com-
ments to edit the original file. Editing the docu-
ment and clicking the “Update Link” button may 
lose the connection between comments and the 
text or graphic to which they were connected, both 
in InDesign and for the reviewers looking at it 
online.

	· There is currently no way to archive the Share for 
Review version with the comments. Attempts to 
save as PDF from InDesign or the online version 
fail as parts of this are unreadable. Until Adobe 
provides a way to archive these drafts, or better 
yet a version management system, simply leave the 
drafts online, make notes of the URL for each draft, 
and leave the InDesign .indd file on your hard 
drive. And go to https://indesign.uservoice.com/
forums/601021-adobe-indesign-feature-requests/
suggestions/40879750-allow-individuals-to-print-
or-save-pdf-from-share and vote for Adobe to fix 
this ASAP.

	· If you are the editor of a document, you can have 
the dated draft in one InDesign tab and the “real” 
file open in another tab. You can look at comments 
in the dated draft, then click Ctrl-Tab to switch to 
the “real” file and make edits.

https://indesign.uservoice.com/forums/601021-adobe-indesign-feature-requests/suggestions/40879750-allow-individuals-to-print-or-save-pdf-from-share
https://indesign.uservoice.com/forums/601021-adobe-indesign-feature-requests/suggestions/40879750-allow-individuals-to-print-or-save-pdf-from-share
https://indesign.uservoice.com/forums/601021-adobe-indesign-feature-requests/suggestions/40879750-allow-individuals-to-print-or-save-pdf-from-share
https://indesign.uservoice.com/forums/601021-adobe-indesign-feature-requests/suggestions/40879750-allow-individuals-to-print-or-save-pdf-from-share
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If and when Share for Review improves to allow real-
time editing by the editor without losing the connection 
between the comments and the text, and adds version 
management, it may bring us at least a semblance of the 
co-editing/real-time collaboration offered by Google 
Docs and Microsoft Word. 

Even with the above procedure, Share for Review has 
a significant advantage over putting a PDF in the Adobe 
Document Cloud: the editor can see the comments and 
suggested edits in the temporary file in real time, and 
use this to start editing the original file. This will likely 
result in the volunteer editor preparing the next draft, or 
the version for approval, significantly more quickly.  

Co-Editing/Real-Time Collaboration 

With co-editing/real-time collaboration, multiple peo-
ple can work on a document at the same time, editing, 
moving blocks of text around, reformatting text and 
adding comments. All of the comments and changes 
remain linked to the text.

In Google Docs, there is only a single way to view the 
text: with inline edits and with comments in a sidebar. 
When a Google Docs document gets heavily edited, it 
can be hard to read and make sense of.

In Microsoft Word there have long been multiple 
ways for reviewers to view the text:
•	 Review > All Markup, No Markup, or Original; 
•	 Review > Show Markup > turn on or turn off 

Comments, Insertions and Deletions, Formatting
	· Balloons > Show Revisions in Balloons, Show All 

Revisions Inline, or Show Only Comments and 
Formatting in Balloons.

	· Specific people: show all, or show or hide com-
ments from certain reviewers.

	· Reviewing Pane: show the reviewing pane either 
vertical or horizontal.

These different ways to view a document’s proposed 
changes far outstrip what Google Docs offers, which is 
only a single view changes with comments in a sidebar. 

It is also far easier to get a properly-formatted 
Microsoft Word file back into InDesign for publication. 

Adding Outline Styles Back to a Word File 

For our documents with an outline format, we can 
export an RTF file from InDesign to make use of 
Microsoft Word’s superior document collaboration 
features. 

Although the heading formats (for example, typeface 
and bold/italic) cross over during the export, the num-
ber/letter outline formats do not cross over. 

Manually formatting the exported file have an outline 
format that looks roughly like the outline in InDesign 
is complex and tedious in the extreme. The following 
process is a seemingly complex but relatively quick 
and painless way to put that outline style back into the 
exported file.

In summary, the procedure is to export an RTF file 
from InDesign, convert to .docx format, and copy the 
outline from a file you have saved on your computer.

Relevant to the procedure below: you cannot export 
.docx files from InDesign, but you can export an .rtf file 
from InDesign, open in Word and then save in native 
Word .docx format. You can then import the .docx file 
back into InDesign.
•	 InDesign > [With Text tool selected, click in text sec-

tion to be exported] > File > Export > [put in desired 
filename and pick RTF as format]; for longer docu-
ments such as the Training Guide, export separate .rtf 
files  for each major section of the document.

•	 In Microsoft Word, open the exported RTF file and 
Save As .docx file; leave your file open in Microsoft 
Word

•	 Microsoft Word > Developer1 > Templates > 
Organizer > Open file with the document’s matching 
Word Paragraph Styles and List Style. (How to create 
such files is covered in “InDesign RTF Editing in 
Word” on page 40.)

•	 Copy all Paragraph Styles and the one List Style to 
the exported file, it should now look somewhat like 
the InDesign version, enough for editing purposes.

•	 Save the modified .docx file
•	 Upload the modified .docx file to the appropriate 

place in the ASRC SharePoint site (home.asrc.net, 
most likely in the Open Working Group area or one 
of the Special Interest Groups)

•	 Once it is uploaded to the SharePoint site, anyone 
with permission can review, comment on and edit 
the file, even at the same 
time that others are review-
ing, commenting on and 
editing the file; you can see 
everyone else’s comments 
and proposed revisions. 

Reviewing in 
Share for Review

Adobe InDesign Share for 
Review is new (2021) and rap-
idly improving. Used carefully, 

1  If not already enabled > File > 
Options > Customize Ribbon > Main 
Tabs > [check Developer check box]

http://home.asrc.net
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and with some knowledge of its limitation and the 
workarounds, it is a powerful tool for collaboration.

The first thing for reviewers is to sign in. When you 
first try to enter a comment, it will offer you the chance 
to create an Adobe ID; it is simple and easy. Don’t 
“Continue as Guest” but “Sign in with Adobe ID.” If you 
“Continue as Guest” you will not get notified of replies 
to your comments. If you “Sign in with Adobe ID” you 
will get those notifications. If you create an Adobe ID 

you don’t get spammed, except with replies to your 
comments.

You can review and comment on Share for Review 
documents online in a browser window. You can also 
right-click the document in your browser window, and 
select Download (the only option) to download to your 
computer. Reportedly you can enter comments offline 
and then upload; we have not experimented with this 
yet.
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Technical Details: Print/PDF  

How to Create Headers

For official internal documents created in Microsoft 
Word, we have some standard templates, as described 
and illustrated in “Stationery and Internal Documents” 
on page 9.

This “How to Create Headers” section is here in case 
someone needs to reproduce part or all of the produc-
tion process, for example, for a new logo or new internal 
document header. Headers and internal document 
formats were originally created in 2017-18 by Keith 
Conover, with input from the entire Board of Directors. 
The procedure used was:
•	 Create the logo in Adobe Illustrator and save it, this 

is the version with editable text on the logo.
•	 To make a version that would look right despite the 

text on a circle confusing PostScript drivers, select 
all the text in the logo and convert it to curves (Type 
> Create Outlines) and save this as a separate file, 
one where the text can no longer be edited, but will 
show up properly in an .eps or .emf file that can be 
put into a Word document and print properly. Save 
this “prints nicely but is not editable” version under a 
separate name. 

•	 Import the version of the logo with curves instead 
of editable text into an Adobe InDesign document, 
sized as 8.5” wide and 2” high (File > Document 
Setup) to create a small letterhead-size graphic. The 
Interal Document Template Header is smaller, 8.5” 
wide x 1.5”high. You don’t want to make something 
as big as a whole 8.5” x 11” page (a) because it’s a big 
file, and (b) it’s too easy to accidentally move it with 
the mouse while editing text if it’s that big. 

•	 Add the green bar and text, save it as an editable-text 
file, and then convert the text with the ASRC name, 
address and URL to curves (Type > Create Outlines). 
Save as a new file with printable but not editable text; 
you should still have the previous editable-text ver-
sion as a separate file. Export the all-curves InDesign 
document to .eps (encapsulated PostScript) format 
(File > Export > .eps).

•	 Convert the .eps file to .emf (Windows Enhanced 
Metafile, something that Microsoft Word can handle) 
using https://cloudconvert.com/eps-to-emf.

•	 Create a blank Word document with standard 1” 
margins. Add in the template text. Change all the text 
in the document to Georgia.  

•	 Drag and drop the .emf file into the top of that Word 
document ; make sure the text anchor is on the very 
first blank line of document, up at the very top. 

•	 Right-click the graphic > Size and Position > Text 
Wrapping Behind Text > Position tab > uncheck 
Move with Text > click OK. 

•	 Drag the graphic to the top of the document, then 
drag the corners (not the sides) so that the graphic 
fits from to side to side. Do not drag the handles on 
the middle of the sides to stretch the letterhead out of 
proportion; the logo should stay a circle, not an oval. 
Now – since Word won’t show you the top margin – 
drag the graphic up until the top of the green bar is at 
the top of the visible page, this will look right when 
printed (in Word, click Print and then look at the 
preview to check.

•	 Right-click the graphic > Size and Position > Lock 
Anchor (doesn’t lock the graphic from accidental 
drags, can’t apparently do that, but does prevent the 
anchor from being dragged to another place in the 
text, for example another page, so is worth doing).

•	 A similar process works for the Internal Document 
and any other Word templates you wish to make.

Book Panel and Syncing

For whoever is working on governance documents in 
InDesign (the “ASRC Publisher”), here are a few helpful 
hints. First, there is an InDesign “book” file (asrc.indb), 
that, if you use it properly, keeps the following items 
synchronized (the same) between all of the ASRC gov-
erning documents:
•	 Text Variables (used for the headings)
•	 Master Pages
•	 Table styles
•	 Cell styles
•	 Object styles
•	 Table of Contents (TOC) styles
•	 Character styles
•	 Paragraph styles
•	 Swatches (colors)

Very important note: for using a Book Panel for 
keeping styles in sync across multiple documents, turn 
off the sequential numbering. Sequential numbering is 
only for chapters in a book. Leaving sequential number-
ing on in a Book Panel will (a) screw up the numbering 
in all of your documents and (b) slow your system to 
a crawl. To turn off sequential numbering in a Book 
Panel:
•	 Book Panel > 
•	 Top right “hamburger menu” icon (three parallel 
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horizontal lines) >
•	 Book Page Numbering Options >
•	 Uncheck Automatically Update Page & Section 

Numbers >
•	 Click OK.

This Branding and Publishing Guide is the “Style 
Source”: when in the ASRC Book Panel, you can select 
all the documents (click first one, shift-click last one) 
and then click the icon at the bottom left to synchro-
nize. When you synchronize, the versions of all of those 
bulleted items above in the Branding and Publishing 
Guide overwrite the equivalent items in all other ASRC 
governing documents.

That means that you should make changes to items 
listed above in the Branding and Publishing Guide, or if 
made in some other document, copy to this Branding 
and Publishing Guide, before you synchronize.

If you need to tweak one of the bulleted items, usually 
a paragraph style there are two options, either to tweak 
an existing style or make a new one. If you make a new 
one, you still copy it into all of the documents so the 
styles are available there in case you want to use them, 
and to keep they style sheets the same for all documents, 
even if some are unused. To do so:
•	 If the change is a fix that should be made in all ASRC 

documents: make the change in the Branding and 
Publishing Guide and then synchronize the asrc.indb 
Book Panel by clicking the icon at the bottom left of 
the asrc.indb Book Panel.
	· Or, modify or add the new item in the document 

in which you need to make the tweak. Then, copy 
into the Branding and Publishing Guide . You do 
this as follows: 

	· Branding and Publishing Guide > 
	· Paragraph Styles Panel > 
	· “Hamburger menu” (three horizontal lines) at top 

left > 
	· Load Paragraph Styles >
	· Pick the document in which you made the change 

>
	· “Uncheck all” >
	· Click the item(s) that you changed >
	· Click OK >
	· Save the Branding and Publishing Guide, (you don’t 

need to close it) >
	· In the Book Panel click top document and then 

shift-click the bottom document to select all of 
them >

	· Click the synchronize button at the bottom left of 
the Book panel, which copies your tweak into all of 
the governing documents.

•	 If the change is a tweak that is unique to a particular 
document and should not be changed in all other 
ASRC governing documents. 

	· Don’t make the tweak in an existing style such as a 
paragraph style. 

	· Instead, make a new paragraph style based on 
the one you want to tweak (right-click and pick 
Duplicate Style is usually easiest, and then rename 
appropriately) >

	· Go into the Branding and Publishing Guide’s 
Paragraph Styles panel, from the hamburger menu 
at the top right, click Load Paragraph Styles >

	· Pick the document you to which you just added the 
new paragraph style >

	· “Uncheck all” >
	· Click the item(s) that you added >
	· Click OK >
	· Save the Branding and Publishing Guide, (you don’t 

need to close it) >
	· In the Book Panel click top document and then 

shift-click the bottom document to select all of 
them >

	· Save the Branding and Publishing Guide (you don’t 
need to close it) > 

	· Click the synchronize button at the bottom left of 
the Book panel, which copies your new paragraph 
style into all of the governing documents.

	· You don’t need to use it in any of the other docu-
ments, but if you do, it’s there.

There are styles that are particular to the needs of 
an individual document. The Articles and Bylaws are 
very different from a document such as the Branding 
and Publishing Guide, so they each use different styles. 
Nonetheless, we can have similar bulleted/numbered 
paragraphs/headings be the same in all documents. 
That is why all of the Paragraph Styles, Character Styles, 
Object Styles, Table Styles and Table of Contents Styles 
are the same in all of the documents.

Some documents like this Branding and Publishing 
Guide are mostly text without any outline-numbered 
sections, some are all outline-numbered like the Bylaws, 
and some are have some of both, such as the Training 
Guide. If you investigate the ASRC TOC (Table of 
Contents) Style, you will see that outline numbers (for 
example, I.) are assigned the same level as a level-one 
text heading (H1); this makes it possible to have a Table 
of Contents for a mixed document such as the Training 
Guide that uses both styles as headings. 

Short documents don’t need a Table of Contents, 
especially if headers help with navigation to the right 
section. But for longer documents and it’s simple 
enough to add a Table of Contents, if the paragraph 
styles are used properly.

There are two sets of settings that should be the same 
in all our governing documents and publications that 
are not synced by the Book Panel. 
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First is Document Footnote Options. This needs to 
be manually configured for each document: Type > 
Document Footnote Options > [leave at defaults except 
as follows]
•	 Numbering and Formatting

	· Restart Numbering Every > [check checkbox], 
select Page

	· Formatting > Footnote Formatting > Paragraph 
Style: Footnote Text

	· Formatting > Footnote Formatting > Separator: 
change from ^t (tab character) to ^> (N dash)

•	 Layout > [leave everything as default]

Second is the cross-reference formatting, which also 
needs to be manually configured for each document: 
Type > Hyperlinks & Cross-References > Insert Cross-
Reference > [leave at defaults except as follows]:
•	 Link to: Text Anchor
•	 Cross-Reference Format > Format: Full Paragraph & 

Text Anchor > [click pencil-icon button to con-
figure] > [check checkbox for “Character Style for 
Reference”] > Hyperlink�

Quick and Dirty Editing in InDesign

If you just need to change a small bit of text in an 
InDesign document, for example, to correct a typo-
graphical error or make a minor change in wording due 
to a Board of Directors decision, you can simply edit the 
text in the regular InDesign WYSIWYG (What you See 
is What You Get) view. 

InDesign has long had a “Story Editor” which shows 
the text without any formatting. But it’s not significantly 
faster than just editing text in the WYSIWYG view. 

And with bigger documents and certain options 
turned on (see below), this editing can be painfully slow. 
To mitigate this, you could copy the text from InDesign 
into Word or any other text editor, edit it there, and then 
paste it back into InDesign. 

However, the new (2021) beta-test Copy Editor Beta 
might make this unnecessary. The beta Copy Editor (not 
the same as the old Story Editor) loads the text, allows 
you to edit it and only dump it back into the format-
ted document once you’re done editing. Editing with 
the new beta-test Copy Editor it is much faster than in 
the formatted document or with the old Story Editor. 
However, when Keith Conover tried it in January 2021 
on this document, it corrupted this document to where 
it would crash with any attempts to edit it further. He 
had to create a new document and copy all the text 
(some of which was difficult to copy) and graphics into 
it; see the thread https://community.adobe.com/t5/

indesign/copy-editor-beta/td-p/11750588?page=1 to see 
how any fix for this is progressing. As of May 2021: no 
news.  

Extensive Editing in InDesign

Some choices for document structure, and formatting 
options that add much to a professional appearance, 
impact InDesign’s performance. So much so that editing 
text, even on a high-end workstation with a fast SSD 
hard drive, is almost impossible; or, if you try editing, 
InDesign will freeze. There are workarounds described 
below. These will likely need to be updated as InDesign 
changes. 

Most important for a long document, including most 
of our governing documents: break the text into several 
sections, each section called a “story” in InDesign 
parlance. If you create or import text into stories that are 
separated at a top-level heading such as the H1 para-
graph style you may never need to employ the work-
arounds described in the rest of this section.

You can do this manually, but it’s more 
tedious and time-consuming than it sounds. 
Instead, download the free JavaScript program 
BreakTextThreadVersion1.0.jsx.1 Add it into InDesign.2 
Use this to break the text into stories at each top-level 
heading paragraph style, such as “H1-new-page” or “H1.” 
This means that when you export a RTF Microsoft Word 
file from InDesign, you’ll have to do it for each story. 
But it is well worth it. If you have created a long doc-
ument and performance in InDesign is slow, this may 
be enough to omit the following work-arounds. This 
probably counts as a best practice rather than a kludge. 
If this isn’t enough to give you good performance in 
InDesign, consider the temporary, likely only-while-ed-
iting, kludges below. 
•	 Don’t have footnotes span columns. It really slows 

things down. And there is no aesthetic or style-man-
ual requirement to do it. This option is currently not 
an option you can keep synchronized with the asrc.
indb Book Panel/book file, so it has to be set manu-
ally for each document. 

•	 Stop level 1 headings from spanning two columns 
for two-column documents. Use InDesign’s Edit 
> Find/Change function to change all the “H1” 
and “H1-new-page” (heading #1) paragraph style 
instances to the “H1-no-span-columns” paragraph 
style. “H1-no-span-columns” is based on, and is the 
same as “H1,” except for two changes: 
	· Paragraph Styles Panel > H1-no-span-columns  > 

Keep Options > Start Paragraph > [changed from 
1  https://github.com/Id-Extras/Break-Text-Thread
2  https://creativepro.com/how-to-install-scripts-in-indesign/

https://community.adobe.com/t5/indesign/copy-editor-beta/td-p/11750588?page=1
https://community.adobe.com/t5/indesign/copy-editor-beta/td-p/11750588?page=1
https://github.com/Id-Extras/Break-Text-Thread
https://creativepro.com/how-to-install-scripts-in-indesign/
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the default Start Anywhere to on Next Page]. 
Having this set to Anywhere produces a more 
compact document, and is appropriate for some 
documents, but it is computationally intense and 
slows down text editing. 

	· Paragraph Styles Panel > H1-no-span-columns  > 
Keep Options > Start Paragraph > [changed from 
the default Start Anywhere to on Next Page] Also, 
the “H1” paragraph style spans both columns, but 
the “H1-no-span-columns headings” does not. This 
also speeds up editing. 

	· Some of the changes suggested above will make 
your document longer, so you may have to: 

	· Add some pages to see all the text
	· Once done editing and you’ve changed this back 

to Start Anywhere, delete the extra blank pages at 
the end, unless you have enabled Smart Reflow (see 
below).

•	 For publications that are use the “I.” outline style 
as a top-level heading, there is also a “I.-no-span-
columns” paragraph style that can also be used 
to speed up editing. Once you’re done editing the 
text, remember to Find/Change to switch all the 
“H1-no-span-column” paragraph styles to “H1” 
or “H1-new-page” styles, and the same for “I.” and 
“I-no-span-columns” paragraph styles. There is 
also  “I.-new-page” and “H1-new-page” paragraph 
styles that can be used for documents, such as the 
Admin Manual or Training Guide, where it is desir-
able to have each new level 1 heading start on a new 
page. 

•	 Another thing that slows text editing is the Balance 
Columns option. Turn this off for each major text 
frame, and only having it on for the page right before 
a page break for a new major section heading. 

•	 Documents that have a large number of footnotes, 
such as the Training Guide, may be very slow when 
editing, so a useful workaround is Type > Convert 
Footnote and Endnote and change all of the foot-
notes to endnotes; the speeds up editing impressively. 
Remember to change them back once done editing, 
and to delete any empty text frames the program 
created to hold the endnotes. 

Smart Reflow 

Smart Reflow automatically adds and deletes pages 
at the end as the text expands or contracts, as it does 
when turning on and off the Balance Columns and Span 
Columns settings. We have found that this causes more 
problems than it solves, especially if you observe the 
best practice of breaking documents into “stories.”  

Here is the process to turn this off for a document if it 
needs to be reset:

Edit > Preferences > Type > Smart Text Reflow View 
> Extras > Show Text Threads will show a line linking 
the two Primary Text Frames on the Master Pages if 
you’ve got it right. You have to click to select one of the 
linked text frames to get the text threads to show.

Master Pages

Master Pages are a very powerful tool to make sure all  
the ASRC governing documents have the same (profes-
sional) look and feel. The ASRC Governing Document 
Master Pages are as follows.
•	 Master Page Spread A  This is for the first two 

pages of each document. Each page has certain fixed 
elements, including the logo and some boilerplate 
text. Each also has a text box for the document short 
title (first page) and the full title and revision date 
(second page). If creating a new document, you have 
to control-shift-click the text box to be able to type 
into it.

•	 Master Page Spread B  This is for the majority of 
pages.

•	 Master Page Spread C  This is for pages that don’t 
need a header, usually the Table of Contents pages, 
and perhaps another page here or there. 

•	 Master Page Spread D  This is the same as Spread 
B, but with Balance Columns turned off for easier 
editing. Unfortunately, as of the time of this revision 
of this section, it still doesn’t work. It’s still here in the 
hopes that Adobe will fix this bug at some point.

Running Headers and Page Numbers 

To deemphasize the headers and page number, which 
after all are usually less important than the text, they 
are all in a tint of gray rather than black. Headers are 
aligned away from the spine.

A web design usability principle is to provide a 
“Breadcrumb Trail” to provide situational awareness 
of where you are in the structure of the website. An 
example: Home > About Us > Contact Information. 
This is a way to reproduce this functionality for a PDF 
or print document in InDesign. Like a clickable Table 
of Contents, it makes it easier to find the appropriate 
section when scanning through the document.

Running headers are defined in an InDesign docu-
ment’s Master Pages, using three defined Type Variables: 
Section, Subsection and Subsubsection. The Section 
variable picks up the text on the page that has the 
HeadText1 character style applied to it; this character 
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style does nothing to the text, but it is a sign to insert 
it into the running header. Similarly, the Subsection 
Text Variable is defined as the text formatted with the 
HeadText2 character style, and Subsubsection with the 
text with HeadText3 character style applied.

The three parts of the header are separated by white 
space. Bullets won’t work as sometimes you will have an 
“orphan” bullet if a Section doesn’t have a Subsection or 
a Subsection doesn’t have a Subsubsection. This is a lim-
itation of InDesign and maybe it will be fixed someday. 

The disadvantage of using a character style for this is 
that you have to apply the character style to some text to 
get it to appear in the running header. Another disad-
vantage is that if you accidentally put a whole bunch of 
text in one of the “HeadText#” styles your header will 
have lots of words all run together in a single place, but 
this is fairly easy to see and fix. It would be easier to 
assign the Section, Subsection and Subsubsection type 
variables to a the paragraph style of a particular level of 
heading. But the advantage of using a manually-applied 
character style – and this is important – is that you 
can apply the HeadText1 or HeadText2 or HeadText3 
character styles to just a portion of the heading. And 
given how the writers of ASRC documents like to use 
very long headings, it’s often a good idea to select just 
the most important portion of the heading to appear in 
the running header. This way, you will have room in the 
header for all three levels of heading. 

One potential problem is this. The Subsection portion 
of the header for a page with a Subsection may carry 
over to the next page, which has a Section with no sub-
sections. (Or, a Subsection header may carry over onto 
a page with a Subsection without any Subsubsections.) 
There is an easy if somewhat tedious fix, as described 
below. 

The following is easier if you have a Table of 
Contents, have it set to create PDF bookmarks, and use 
the Bookmarks Panel to quickly navigate to each of the 
H1 and H2 and H3 headings, which in itself is a great 
trick for quickly navigating a long document. It does 
require that you manually update the Table of Contents 
on a regular basis to make it point to the correct pages 
after any significant edits to the document. (Cursor in 
Table of Contents > Layout > Update Table of Contents.) 

The following is also easier with Type > See Hidden 
Characters on so that you can see the spaces at the end 
of the headings.

Start by setting up four heading paragraph styles 
named H1, H2, H3 and H4. The standard ASRC 
InDesign format in this document, which is used in an 
asrc.indb book file as the Style Master for all the rest 
of the ASRC documents (a great way to quickly syn-
chronize styles across all ASRC documents) has this 
already done for you. Create a Table of Contents using 

the ASRC Table of Contents Style, and include all four 
of these in your Table of Contents. For H1, H2 and H3 
headings, the heading, or an abbreviated version of it, 
will appear in your breadcrumb header. The H4 heading 
will appear in the Table of Contents but not in the 
headers. Four items in a breadcrumb header is just too 
much. If a section with an H1 heading has no H2 or H3 
headings within it, you need to set up things so that the 
H2 or H3 headings from the prior H1 section will not 
carry over in the page header.

Set up three character styles named HeadText1, 
HeadText2, and HeadText3, again done for you in this 
document that will, if you use the asrc.indb book file 
as a Book Panel, carry over into all the other ASRC 
documents if use the asrc.indb Book Panel to synchro-
nize them to you new document. Make no changes to 
the default character style formatting for these character 
styles. These “character styles” do nothing to change 
the formatting of the text, they only exist to allow the 
breadcrumb headings to use a subset of the full head-
ing text. Whatever portion of the H1 heading you have 
formatted with the HeadText1 character style will appear 
in the breadcrumb header. For long H1 headings this 
allows you to have a short version of the heading’s text 
appropriate for a breadcrumb header at the top of the 
page. For short H1 headings you apply HeadText1 to the 
entire heading text rather than a shorter portion of the 
heading text.

Set up three Text Variables, Section, Subsection, 
and Subsubsection, set to the character styles as 
follows:

Section: character style HeadText1, Last on Page
Subsection: character style HeadText2, Last on Page
Subsubsection: character style HeadText3, Last on 

Page
In your document, format an appropriate-sized por-

tion of each of your H1 headings with the HeadText1 
character style. If the H1 heading is short, you can apply 
the HeadText1 character style to the entire heading. 
Make sure this character style does not extend into the 
paragraph mark (visible with Text > Show hidden char-
acters) at the end of the heading, or into the subsequent 
text.

Do the same for all of your H2 heading’s text with 
the HeadText2 character style.

Do the same for all of your H3 heading’s text with 
the HeadText3 character style.

At the end of your first H1 heading, type a space, 
and then format it with the HeadText2 character 
style. Note that’s the HeadText2 character style, not 
the HeadText1 character style. This is to prevent any 
H2 or H3 headers from the previous section to carry 
over, which can be a problem if your current H1 section 
doesn’t have any H2 headings.
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At the end of your first H1 heading’s space format-
ted with the HeadText2 then type another space and 
format it with the HeadText3 character style.

Select and then copy both of these spaces to the 
clipboard.

Using your Bookmarks panel, double-click on the 
next H1 heading to go to it.

At the end of that H1 heading, paste your two charac-
ter-style-formatted spaces. Do this for each H1 heading.

At the end of your first H2 heading, add a space 
formatted with the HeadText3 character style. Select it, 
copy it to the clipboard, then double-click all of the H2 
headings in your Bookmarks Panel to go to them and 
paste your character-style-formatted  space to the end of 
each of these headings.

One problem with this is when you accidentally 
format an entire paragraph with, for example, the 
HeadText2 style, InDesign tries to fit the entire para-
graph into the header with predictably bad results. 
The fix is easy, select the offending paragraph with a 
quadruple-click, then up at the top, change the character 
style to None.

Sometimes a paragraph mark has been formatted 
with, for example, the HeadText2 style and the header 
will look back to the beginning of the document to pick 
the text for a header. Changing the offending para-
graph’s or paragraph mark’s character style to None, 
or when you can’t easily figure out where the errant 
character style is hiding, deleting a heading and retyping 
it, fixes these problems.

One note about the header: on a master page, if you 
use the menu: Type > Text Variables > Insert Variable > 
Subsection, you will see something that looks like 
<Subsection> 
However, this is not the same as simply typing the letters 
for 
<Subsection> 
so don’t confuse the two.

InDesign RTF Editing in Word 

At least at the time this was written, Microsoft Word 
offers superior online document collaboration features, 
such as commenting and suggesting edits. Thus, our 
interest in exporting RTF files from InDesign (that’s the 
only type of text file InDesign will export) and editing 
them using Microsoft Word.

This requires converting them to Microsoft Word 
.docx files, which then can be imported back into 
InDesign. But RTF files exported from InDesign, even 
when saved as native Microsoft Word .docx files, lose 
all of the numbered/lettered outline formatting of our 
outline-heavy documents. 

Trying to manually apply outline styles to the 
exported file is both time-consuming and very, very 
complicated.  

Thus, the interest in adding those outline numbers 
back into the exported RTF document by a faster 
method than manually doing so for each exported doc-
ument, which can also complicate getting the revised 
document back into InDesign.

It is possible to use the Microsoft Word Template 
Organizer to copy Microsoft Word Outline Styles and 
Paragraph Styles from one document or document tem-
plate to another document or document template. This 
will allow the exported RTF file, to some degree, to have 
the same outline numbering as it had in InDesign.

This section explains how to prepare to get a .rtf file 
(currently just of the Training Standards) exported from 
InDesign modified to reproduce the outline formatting 
seen in InDesign. 

Once you have prepared for this, it’s fairly simple to 
export a RTF file, copy Microsoft Word Paragraph Styles 
and a Microsoft Word List Style into the RTF file, and 
put it online for collaborative editing. That process is 
explained above in “Exporting a RTF File and Editing 
Online” on page 30.

InDesign Outline Structure

In InDesign, the outline structure is entirely stored in 
the Paragraph Style. That means you can use multiple 
different Paragraph Styles that have the same level in the 
outline. 

For example, in the Bylaws, the name of the top-level 
heading’s Paragraph Style is named “Article I.” The 
automatic numbering embedded in this makes the first 
such paragraph look like the following (this is just a 
simulation as we don’t want to mess up the Branding 
and Publishing Guide’s numbering):

Article I. Organization and 
Roles
In this heading, the text “Article” is hard-coded into the 
InDesign Paragraph Style named “Article I.”, and the 
automatic numbering in that Paragraph Style is set to 
put in the Roman numeral I for the first occurrence of 
the paragraph, the Roman numeral II for the second, 
and so on. 

But we want the heading Preamble, which comes 
before Article I, to look the same, and appear at the same 
top level (Level 1) in the Table of Contents. 

To do so, we create an InDesign Paragraph Style 
named “Preamble”. It has the same typeface (Scala Sans 
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Pro) and weight (bold) as the InDesign Paragraph style 
“Article I.” We make sure that it has no numbering 
assigned to it. 

Then, to the “ASRC Document TOC” Table of 
Contents style, we add the InDesign “Preamble” as well 
as “Article I.” Paragraph Style, both as Level 1 entries. 
(The ASRC Document TOC style also have Level 1 
entries for appropriate top-level Paragraph Styles from 
other documents that should also appear in the Table of 
Contents. Examples include H1, H1-new-page (which 
is the top-level heading in this Branding and Publishing 
Guide) and I. which is just like Article I. but without the 
text “Article” automatically inserted before the Roman 
numeral.

There is also the problem that, in documents such 
as the Training Guide, there must be two different 
InDesign Paragraph Styles for paragraphs at the third 
level down. Here is a (simulated) example of part of the 
outline structure for the Training Guide, without the 
intervening text:

Field IV (Trainee) 
Curriculum
A. Safety, Health and First Aid

1. Mid-Appalachian SAR Hazards and Risks

     a. Subjective vs Objective Hazards
…

B. Communications

1. Goal: accurate, clear, and effective reports over radio

    a. Before speaking:
…
In A. Safety, Health and First Aid, the first topic, 1. 

Mid-Appalachian SAR Hazards and Risks, is a heading 
for a long section with many subsidiary headings and 
lots of text. The authors wanted this emphasized as a 
heading, rather than just another chunk of text. They 
also wanted to include this in the Table of Contents. 

But in B. Communications, the authors considered 1. 
Goal: accurate, clear, and effective reports over radio, to 
be just a chunk of outline-numbered text. They didn’t 
want it emphasized as a heading, and didn’t want it in 
the Table of Contents.

This disparity in the depth of outline-structured text 
occurs in many ASRC documents and publications.

To deal with this, we have two separate InDesign 
Paragraph Styles, the first, “1.”, the second, “1. as 

heading”. The second is in the ASRC Table of Contents 
Style as a heading, the first is not. The second is in bold, 
the first is not. Since you want “1. as heading” to be the 
same  as “1.” except for the typeface, the easiest way to 
create it is to duplicate it. In the Paragraph Styles Panel, 
right-click the “1.” Paragraph Style and click Duplicate.

Microsoft Word Template Files

Microsoft Word allows you to save a Word file (.docx file 
extension) as a Word Template file (.dotx file extension). 
For the files described above, containing the appropriate 
Word Paragraph Styles and List Style, it’s best to save 
as a Word Template file with a .dotx extension, and for 
those who are formatting the exported RTF files, to put 
them in their Word Templates folder.

Why?
Because when they have the exported RTF file open 

in Word, and open the Template Organizer, it automat-
ically opens to the Word Template folder, making it 
easier to find the Templates there. That presumes that 
you have instructed them to put those template files into 
that folder. On Windows PCs, that folder is usually:

C:\Users\[your computer account abbreviation here]\
AppData\Roaming\Microsoft\Templates

Microsoft Word Outlines

As observed at the outset of this section, in InDesign, 
the automatic numbering is integrated into InDesign 
Paragraph Styles. Although there are separate InDesign 
Table of Contents Styles, there are no separate InDesign 
Outline Styles. 

But in Microsoft Word, an Outline Style with 
automatic numbering is a quite separate thing from 
Microsoft Word Paragraph Styles. 

In a Word document, you can bind a Word Paragraph 
Style to a particular level, which ends up functioning 
somewhat similar to InDesign Paragraph Styles that are 
structured to include outline numbering.

However, and this is a critical difference: in a Word 
document, you cannot have more than one Paragraph 
Style attached to a particular level of a Microsoft Word 
Outline Style. Unless those two Paragraph Styles are 
linked in the sense that one is based on the other.

Thus, for the problem described in the previous sec-
tion for dealing with the InDesign Paragraph Styles “1.”, 
the second, “1. as heading”, you just need to base the 
second on the first. One you have created and formatted 
the “1.” heading:

Word Styles Panel > bottom-left New Style button > 
Name the style “1. as heading” > click in Style Based on 

Why not do like in InDesign and simply duplicate 
the “1.” Paragraph Style? Simple. Duplicating a style in 
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Microsoft Word is not simple like in InDesign. You have 
been warned. If you want to do so, the procedure:

With the Word file in which you’re creating the Word 
paragraph styles open, and once you’ve created and 
styled your “1.” Word Paragraph Style, do the following:
•	 Developer > Document Template > Organizer (bot-

tom left)
•	 On the right, you should see your default template 

file, Normal.dotm (global template)
•	 On the left, select the “1.” Paragraph Style. 
•	 Click the “Copy ->” button to copy the “1.” 

Paragraph Style to Normal.dotm on the right. 
•	 On the right, in Normal.dotm, select the “1.” 

Paragraph Style, click Rename, rename as “1. as 
heading.” 

•	 On the right, in Normal.dotm, select the “1. as head-
ing” paragraph style and click the “<- Copy” button 
to copy to this file to the left.

•	 On the right, in Normal.dotm, select the “1. as head-
ing” paragraph style and click Delete and then Yes to 
confirm the deletion. 

•	 At the bottom left of the Organizer, click Close.
•	 You now have a duplicate style that you can modify. 

Remember to changed to “Style based on” to “1.”

Word List Styles

To create or modify a Microsoft Word List Style:
•	 Open a new Word file (standard Word file with the 

.docx file extension, you will save as a Word Template 
file with the .dotx file extension later) and create in it 
the List Style you want to have to match a particular 
document. Save the file with a name that matches 
the main outline style of the document.  Creating 
a new multilevel List Style, or modifying one, is 
tricky. For good background with illustrations, see: 
https://shaunakelly.com/word/numbering/number-
ing20072010.html. 

•	 The most important lesson in the above web page is 
that, to connect your Paragraph Styles with your List 
Style, you must:
	· Click the down arrow to the Multilevel Style icon, 

then either (to create the List Style in the first 
place): click Define New List Style, or (to modify a 
List Style) hover your mouse over a list style to see 
the name, and then right-click and click Modify

	· At the bottom left of the dialog box, click Format
	· Click Numbering
	· At the bottom left, click More if it’s there
	· Make sure that for each level, except the top level, 

that the box “Restart list after” is checked, and 
after the checkbox it shows the level just above; 
for example, level 2 should restart numbering after 

each level 1.
	· Near the top right of the dialog box, make sure 

each level of the list is linked to the appropriate 
Paragraph Style.

Other Paragraph Styles

It helps if you can style a few other Paragraph Styles, 
not major-outline headings, in Word as they are in 
InDesign. You will need a second Word List Style to deal 
with the two levels of bullets, and make the “with space 
after” variants “Style based on” the version without the 
space after to get the Word List Style to work. It is OK to 
put them in all of the Word Template .dotx files even if 
they aren’t used. For example, the Credentialing Policy 
Manual doesn’t (currently) have any bullets. 
•	 “Bullet” paragraph style
•	 “Bullet with space after”  paragraph style (for the last 

in a series of bullets with a “Body” paragraph after it)
•	 “Bullet Indent 1” paragraph style
•	 “Bullet Indent 1 with space after ” paragraph style
•	 “Body” paragraph style
•	 “FirstPara” paragraph style (same as body but no 

indent at the beginning)

Word Template Files

In InDesign we can have one set of Paragraph Styles 
(which include the outline styles within them) and have 
the same in all ASRC documents and publications. 
But in Microsoft Word, only one Paragraph Style, or 
that Paragraph Styles that are “Styles based on…” that 
Paragraph Style, can be linked to a particular Word 
Outline Style. That means that for styling exported RTF 
files, we have to use several separate Word Template 
(.docx) files, each with its own main List Style.

You can then use the Microsoft Word Template 
Organizer to copy all of the Paragraph Styles and the 
one List Style from that Word file into the exported RTF 
file. Then, when you look at the RTF file in Microsoft 
Word, the outline numbering will look correct. Mostly. 

Here is a list of the Word Template files that need to 
be created to allow this method of formatting exported 
RTF files. As we gain experience with this process it will 
be expanded and updated. These are easiest to use if you 
copy them all into your Word Templates folder, as that is 
where the Word Templates Organizer will first look for 
them.
•	 H1-new-page-A-1-a-i.dotx, for:

	· ASRC Training Guide; note that the Training 
Guide also uses the Paragraph Styles H2 and H3 
in the Overview, and most of our documents use 
the Change History Heading Paragraph Styles, but 
as they include no numbering, there is no need to 

https://shaunakelly.com/word/numbering/numbering20072010.html
https://shaunakelly.com/word/numbering/numbering20072010.html
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attach them to the Outline Style. And the format-
ting from InDesign carries over into Word, so there 
is no need to create matching Paragraph Styles in 
Word to deal with them.

•	 I-A-1-a-(1)-(i).dotx, for: 
	· Credentialing Policy Manual 

•	 H1-new-page-H2-H3-H4.dotx, for: 
	· Branding and Publishing Guide

Training Standards Notes 

To get the capital-lettered sections (paragraph style “A.”) 
to start over at A for each section, you have to go into 
the Paragraph Style for the heading style “H1-New-Page” 

and in the Bullets and Numbering section:
•	 List Type: Numbers
•	 List [Name]: List 1
•	 Level: 1
•	 Remove the contents of the Number text field
•	 Mode: Start at 1 and this will ensure that each Level 

starts with A.

Bylaws Notes 

Non-numbered paragraphs in the Bylaws generally 
format best with the 1.1 paragraph style, with a tab at the 
beginning. 
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Historical Background  
Things have changed since the ASRC was first founded 
in 1974. In those days, we had black and white statio-
nery printed by a commercial printer. Gene Harrison 
hand-drew the logo design. The little line near the 
bottom is Gene’s initials and the date. The printer put 
“Appalachian Search & Rescue Conference” text right 
at the top in News Gothic in a heavy weight (Smallcaps, 
Black or Heavy), a typeface weight that has never been 
digitized and is no longer available. An example is below 
after the sample one-pager.

We chose the colors for the patch, which later became 
a color logo, from the thread colors the manufacturer 
had available. On this page is a scan of one of the 
original 100 numbered patches the ASRC had made. 
The staff in the center was of silvery metallic thread. 

The snake was originally a bit yellower but has faded to 
an orange shade over the past 40 years. We asked for 
silvery gold thread for the snake but they didn’t have 
any. Note that the letters in the original logo and patch 
are not an actual font, but drafted so that the vertical 
portions of the letters are along radial lines out from the 
center of the logo, as shown on the next page. 

In January 2017 Treasurer Victoria Airey proposed 
the we consider changing the logo to use the Scala Sans 
typeface instead of the drawn letters. Three versions 
using the Scala Sans typeface and the original design 
were the subject of a poll, and the current version with 
the small diamond-shaped bullets won, so in January 
2018 the Board of Directors voted to change the logo. 
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Change History  
Old versions are posted in the ASRC Archive at http://
archive.asrc.net.

October 2021 (Version 1.4)
•	 Renamed to Branding and Publishing Guide.
•	 Entirely revamped the system for providing award 

certificates.
•	 Much more detailed information on the ASRC 

website.
•	 Minor edits throughout.
•	 Updated some of the very technical parts with new 

knowledge to guide those dealing with these issues in 
the future.

•	 Much reorganization of sections.
•	 New section on document collaboration with a new 

table.

April 2020 (Version 1.3)
•	 Clarified policy with a new section on Intellectual 

Property. The Master Pages for all ASRC documents 

were changed based on this information, as were the 
slide masters.

•	 Significant technical changes in the Technical Details 
section and one minor change to the standard 
Agenda and Minutes format and templates.

•	 Added material on intellectual property, copyright 
and Creative Commons licensing

•	 Updated the slide masters
•	 Minor other changes throughout

April 2018 (Version 1.2)
•	 Changed to the new logo with Scala Sans lettering.
•	 Updated to the new stationery template, and added 

the internal document template, including a template 
for the Agenda and Minutes. 

•	 Added a wide-format slide template and notes on 
how to create ASRC slide templates.
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